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UNIT – I
Computer
It is an electronic device which is used to perform both arithmetic and logical operations. Earlier the size of the computer is huge in size
Characteristics of computers
1. Speed:
A Computer processes the data with high speed. It can perform millions of arithmetic and logical instructions per second. The speed of computers is usually given in nanoseconds and picoseconds where 1 nanosecond=1 x 10-9 seconds and 1 picoseconds = 1 x 10-12 seconds.
2. Accuracy: 
Computer can perform each and every calculation very accurately. A computer is fast, reliable and robust electronic device. 
3. Automation:
Besides being very fast and accurate, computers are automatable devices that can perform a task without any user intervention. The user just needs to assign the task to the computer, after which it automatically controls different devices attached to it and executes the program instructions.
4. Diligence: 
Unlike human beings, a Computer is free from monotony, tiredness, lack of concentration etc. Hence it can work continuously without any errors and with the same accuracy.
5. Storage: A Computer can store and retrieve any amount of information.
6. Versatility: A Computer can be used for diversified functions.
Limitations of Computer:
1) No IQ: 
Although the trend today is to make computer intelligent by inducing artificial intelligence in them, they still do not have any decision-making abilities of their own. Thus, their IQ level is zero. They need guidance to perform various tasks.
2) No Feelings
Lack of feeling is another limitation of computer. A computer cannot feel like us. It does not have emotions, feelings, knowledge, etc. It does not get tired and keep on doing its tasks. It can do very risky works which are not capable by human beings.
3) Lack of common-sense
This is one of the major limitations of computer systems. No matter how efficient, fast and reliable computer systems might be but yet do not have any common sense because no full-proof algorithm has been designed to programme logic into them. As computers function based on the stored programme(s), they simply lack common sense.
4) Economical
Today, computers are considered as short-term investments for achieving long-term gains. Using computers also reduces manpower requirements and leads to an elegant and efficient way of performing various tasks. Hence, computer saves time, energy and money



Evolution of computers
The development of the computer is based on the idea of calculator. The first calculating device is ABACUS which was invented by Chinese in 2000 years ago. It is a wooden frame in which beads are threaded on wires. It is still used in the nursery schools for teaching basic arithmetic operations.
In 1642, BLAISE PASCAL a French mathematician developed a calculating machine called PASCALINE. The machine was also used for addition and subtraction purpose. The device was operated by dialing a set of wheels. In 1671 LEIBNIZ improved on Pascal's adding machine and invented the LEIBNIZ's Calculator.
In 1823 Charles Babbage an Englishman invented a Difference Engine to calculate algebraic expressions. The purpose of this device was to calculate the roots of polynomial equations and prepare astronomy table for the British Navy. He upgraded this in 1833 to, invent an Analytical engine, which could store program instructions initially coded on punched cards and subsequently shared internally. Therefore Charles Babbage is known as the father of computers.
Dr. HERMANN HOLLERITH, an American made an improved type of mechanical computer in 1890 which works with punched cards. This equipment read the holes punched in the card and mechanically performed the statistical analysis.
The first pure electronic computer was invented by J. V. ATANASOFF and C. BERRY which is known as ATANASOFF-BERRY COMPUTER or ABC.  It used vacuum tubes for both data storage and data computation.  Subsequently the first electronic calculator called ENIAC (Electronic Numerical Integrator and calculator) was designed by Dr. JOHN MAUCHLY and J.P ECKERT in 1945 and it is accepted as the general purpose computer.
In 1948 JOHN VON NEUMANN developed a computer called EDVAC (Electronic Discrete Variable Automatic Computer) in which the first stored program concept used. The next important development was the UNIVAC (UNIVERSAL AUTOMATIC COMPUTER) developed in 1951 and this is considered as the first generation computer.









Generations of Computers
Computers developed after ENIAC have been classified into the following five generations. The generations of computers are classified into 5 types based on the size of computer and speed of computer.
1. FIRST GENERATION COMPUTERS (1940-1956):
· The first generation computers used vacuum tubes to store and process information. 
· The vacuum tubes consumed lot of power and generated too much heat.
· They required cooling systems to keep the temperature low. 
· The first generation computers were huge in size and had limited memory and processing power. 
· They were slow, expensive and often undependable.  The first generation computers are Very big in size, weight and occupied large space. 
· During this period, computer programming was mainly done in machine language.  
· UNIVAC AND ENIAC are prime examples of first generation computing devices. Moreover, UNIVAC was the first commercial computer delivered to a business client(US Census Bureau in 1951)
Ex: UNIVAC, IBM-701
Advantages:
1. They were the fastest calculating devices of their time.
Disadvantages:
1. They generates a lot of heat
2. They consumed a lot of electricity
3. They were very bulky in size.
4. They were expensive
5. These computers had limited commercial use because they were difficult to program.
2. SECOND GENERATION COMPUTERS (1956-1963)
· In 1948 three scientists, John Bardeen, William Shockley and Walter Brattain, invented transistor at the AT&T‘s Bell Labs. This invention started a big revolution in electronics. These transistors replaced vacuum tubes in the second generation computers. 
· The transistors did the same function of vacuum tubes more efficiently. 
· Each transistor was equivalent to 40 vacuum tubes. 
· It requires less power and generates less heat than vacuum tubes. The size of second generation computer is reduced and speed increased.
Ex: UNIVAC-1108, MARK-III
Advantages:
1. They consumed less electricity and thus generates less heat as compared to the first generation computers.
2. They were faster, cheaper, smaller and more reliable than their first-generation computers.
3. They could be programmed using assembly language and high-level languages.
4. These computers had a faster primary memory and a larger secondary memory.
Disadvantages:
1. Second generation computers were manufactured using transistors, which had to be assembled manually. This made commercial production of computers difficult and expensive.
3. THIRD GENERATION COMPUTERS (1965-1970)
· The development of the IC was the hallmark of the third-generation computers. Several electronic components such as transistors, resistors and capacitors were miniaturized and placed on silicon chips, called integrated chips, which drastically increased the speed and efficiency of computers. 
· Integrated chips were smaller, less expensive, more reliable and faster in operation, consumed less power, and generated less heat than the components used earlier.
· Introduction of mini computers &programming languages.
Ex:  PDP-ii, ICL-2903
Advantages:
1. They were faster than second generation computers and could perform one million transactions per second.
2. They were smaller, cheaper and more reliable than their predecessors
3. The computers had faster and larger primary memory and secondary storage.
4. These computers were widely used for scientific as well as business applications.
5. In this generation of computers, standardization of existing high-level languages and invention of new high level languages happened.
Disadvantages:
1. These computers were difficult to maintain
2. They got heated very quickly
4. FOURTH GENERATION COMPUTERS (1971-1985)
· Replacement of LSICs by VLSI
· Introductions to micro computers (PCs)
· Requires Low Power.
· Very high speed in operation.
· Works more efficiently than third generation computers.
Ex:  HCL, Apple –II
Advantages:
1. These computers were smaller, cheaper, faster and more reliable than their predecessors
2. They consumed less electricity and generated less heat
3. They had faster and larger primary memory and secondary storage.
4. They could be used as general-purpose computers
5. Networks allowed sharing of resources, thereby enabling efficient utilization of computer hardware and software.
Disadvantages:
1. They were not intelligent systems


5. FIFTH GENERATION COMPUTERS (1985 onwards)
· These generation computers are completely based on the new concept of Artificial Intelligence. Although such computers are still in development, there are certain applications such as voice recognition that are widely being used today. 
· Parallel processing and superconductor technology have made AI a reality. 
· Quantum computation and nanotechnology will radically change the face of computers in the year to come.
· In the fifth generation computers, the aim is to develop devices that respond to natural language input and are capable of learning and self-organization. 
· Large memories.
· Acceptance of spoken and written commands.
· Super high in operations.
· Introduction to super computers.
Types of Computers
Computers vary widely in terms of their size and purpose they serve. Computers can be classified on several bases as follows. 
1. On the basis of electronics or the operating principle, they can be classified into:
a. Analog Computers
b. Digital Computer
c. Hybrid computer
2. On the basis of size, Digital computers are classified into
a. Portable computer
b. Desktop computer
c. Minicomputer
d. Mainframe computer
e. Super computer
3. On the basis of purpose
a. Special Purpose computer
b. General Purpose computer
1. On the basis of electronics or the operating principle, they can be classified into:
1) ANALOG COMPUTER: 
i. Analog computer operates on inputs of continuously varying electrical voltage. 
ii. It measures the input rather than counting. 
iii. The name that is derived from the Greek word ‘analog’ denotes that the computer functions by establishing similarities between two quantities that are usually expressed as voltages or currents. 
iv. Analog computers are powerful tools to solve differential equations. 
v. They are mainly used to be constructed to do a specific job and will respond very quickly to changes in the measured inputs.

2) DIGITAL COMPUTER: 
i. A digital computer operates essentially by counting. All quantities are expressed as discrete digits or numbers and computations are done with numerical digits. 
ii. Mathematical expressions are represented as binary digits and all operations are done using these binary digits at a very high rate. 
iii. The digital basically knows addition. It converts other operations into addition then Calculate. 
iv. It is much faster than analog computer.
3) HYBRID COMPUTER: 
i. Hybrid computer combines features of both analog and digital computers. 
ii. In this computer some calculations are done in the analog portion of the computer and some are done in the digital portion of it.
2. On the basis of size, Digital computers are classified into
1) Portable Computer: 
Portable computer is very small, easy to use microcomputer. The users can carry it wherever they go. Business executives, traveling salesman etc, carry it during travel for personal use. This group includes pen based computer, hand held computer, note book computer and laptop computer.
2) Desktop Computer: 
The desktop computer is a small general-purpose microcomputer, but larger than portable computers. It is normally installed on a desktop and hence the name desktop computer. It is a self-contained system, usually designed for use by one person at a time. Since the desktop computers can be easily linked to large computers.
3) Mini Computer:
It is a medium sized computer that is costlier and more powerful than a microcomputer. This can support several users at a time, with multi-terminal, time-sharing system. Minis are the popular data processing systems among the business organizations today. They are mainly used as departmental computers in large and medium-sized organizations. They are also used in government departments, universities. 
4) Mainframe Computers:  
The earliest computers were called mainframes due to their size. The term is still used for the large computers today. They have large storage capacities, very high speed of processing, very high speed of processing and can support a large number of terminals for use by a variety of users simultaneously. They are kept in air-conditioned environment in a special computer room. They are used by big companies, banks, government departments etc as their main computer. 
5) Super Computer: 
This has extremely large storage capacities and computing speeds that are at least ten times faster than that of other computers. They super computer is used for large-scale numerical problems in scientific and engineering disciplines. These include applications in electronics, petroleum engineering and weather forecasting. This has traditionally been used in scientific and military organizations.
3. On the basis of purpose
1) Special Purpose computers 
These are computers designed to carry out specific tasks. They have in-built programs which are stored in a part of the main memory called Read-Only Memory. The content of this part of the memory can be accessed and executed by the computer, but cannot be modified by the programmer or the user. Thus, the operations that can be carried out by this type of computer are pre-determined at the time of manufacture. The computer cannot be used for any other purpose. 
2) General Purpose Computer 
These are computers that are not specifically designed or built for specific jobs. They solve various kinds of problems depending on the program or software loaded into them. Their main memory is typically Random Access Memory (RAM) - a temporary storage that looses its contents when the computer is switched off. It is easy to change the contents of RAM, substituting one program for another and this is what makes them general-purpose computers. 
Applications of Computer
Computers play a role in every field of life. They are used in homes, business, educational institutions, research organizations, medical field, government offices, entertainment, etc.
1. Home
Computers are used at homes for several purposes like online bill payment, watching movies or shows at home, home tutoring, social media access, playing games, internet access, etc. They provide communication through electronic mail. They help to avail work from home facility for corporate employees. Computers help the student community to avail online educational support.
2. Medical Field
Computers are used in hospitals to maintain a database of patients’ history, diagnosis, X-rays, live monitoring of patients, etc. Surgeons nowadays use robotic surgical devices to perform delicate operations, and conduct surgeries remotely. Virtual reality technologies are also used for training purposes. It also helps to monitor the fetus inside the mother’s womb.
3. Entertainment
Computers help to watch movies online, play games online; act as a virtual entertainer in playing games, listening to music, etc. MIDI instruments greatly help people in the entertainment industry in recording music with artificial instruments. Videos can be fed from computers to full screen televisions. Photo editors are available with fabulous features.
4. Industry
Computers are used to perform several tasks in industries like managing inventory, designing purpose, creating virtual sample products, interior designing, video conferencing, etc. Online marketing has seen a great revolution in its ability to sell various products to inaccessible corners like interior or rural areas. 
5. Education
Computers are used in education sector through online classes, online examinations, referring e-books, online tutoring, etc. They help in increased use of audio-visual aids in the education field.
6. Government
In government sectors, computers are used in data processing, maintaining a database of citizens and supporting a paperless environment. The country’s defense organizations have greatly benefitted from computers in their use for missile development, satellites, rocket launches, etc.
7. Banking
In the banking sector, computers are used to store details of customers and conduct transactions, such as withdrawal and deposit of money through ATMs. Banks have reduced manual errors and expenses to a great extent through extensive use of computers.
8. Business
Nowadays, computers are totally integrated into business. The main objective of business is transaction processing, which involves transactions with suppliers, employees or customers. Computers can make these transactions easy and accurate. People can analyze investments, sales, expenses, markets and other aspects of business using computers.
9. Training
Many organizations use computer-based training to train their employees, to save money and improve performance. Video conferencing through computers allows saving of time and travelling costs by being able to connect people in various locations.
10. Arts
Computers are extensively used in dance, photography, arts and culture. The fluid movement of dance can be shown live via animation. Photos can be digitized using computers.
11. Science and Engineering
Computers with high performance are used to stimulate dynamic process in Science and Engineering. Supercomputers have numerous applications in area of Research and Development. Topographic images can be created through computers. Scientists use computers to plot and analyze data to have a better understanding of earthquakes.
Block diagram of computer
The block diagram of computer consists of different units. They are
1) Input Unit
2) CPU
3) Memory Unit
INPUT UNIT: 
It is used to send data or programs in to the computer system. The following functions are performed by input unit.
· It accepts the list of instructions and data from the outside world.
· It converts these instructions and data in computer acceptable form.
· It supplies the converted instructions and data to the computer system for further processing.
[image: C:\Documents and Settings\Sri Hari\Desktop\block-diagram-of-computer-02-3-638.jpg]There are various kinds of input devices available. They are keyboard, mouse, Light pen, Joystick, Scanners, Touch Screen, OMR, etc.

CPU: 
It stands for Central Processing Unit. The CPU is the brain / heart of any computer system. The CPU is also responsible for activating and controlling the operations of their units of a computer system. It is made of three units .They are – 
1. Memory Unit 
1. Arithmetic Logical Unit 
1. Control Unit
MEMORY UNIT:
The function of the memory is to store data or instructions or information in the form of Zero/off (0) or one/on (1) states.0 or 1 is called as BITS (binary digits). The memory unit is of 2 types. They are –
0. RAM:
· It stands for Random Access Memory. 
· Here data can be stored temporarily, so this type of memory is called as a temporary memory or volatile memory because when power fails the data from the RAM will be erased. 
· The information stored in the RAM is basically loaded from the computer’s hard disk and includes data related to the operating system and applications that are currently being executed by the processor.  
· RAM is considered random access because any memory cell can be directly accessed if its address is known. RAM is of different types, such SRAM, DRAM AND VRAM.
0. ROM:
· It stands for Read Only Memory. 
· In this the data will be provided by the manufacturers regarding the system, so this information can simply be read by the user but cannot add new data or it cannot be modified. 
· ROMs are of different types
1. PROM
A programmable read-only memory (PROM) is a form of digital memory where the setting of each bit is locked by a fuse or antifuse. It is one type of read-only memory. The data in them are permanent and cannot be changed. 
· EPROM
Erasable Programmable Read Only Memory is full erasable programmable read-only memory form of computer memory that does not lose its content when the power supply is cut off and that can be erased and reused.
1. EEPROM
EEPROM stands for electrically erasable programmable read-only memory and is a type of non-volatile memory used in computers, integrated in micro-controllers for smart cards and remote keyless systems, and other electronic devices to store relatively small amounts of data by allowing individual bytes to be erased and reprogrammed.
CONTROL UNIT (CU):
· It stands for Control unit. 
· It manages and coordinates the entire computer system. 
· It obtains instructions from the program stored in main memory, interprets the instructions, and issues signals that cause other units of the system to execute them.

ARITHMETIC LOGICAL UNIT (ALU):
· It stands for Arithmetic and Logic Unit. 
· It performs the arithmetic and logical operations. 
· Arithmetic operations mean addition, subtraction, multiplication, division etc., whereas the logical operation means comparisons and decision-making.
OUTPUT UNIT:
The job of an output unit is just the reverse of that of an input unit. As computers work with binary code, the results produced are also in the binary form. Hence before supplying the results to the outside world it must be converted to human acceptable form. This task is accomplished by the output unit.  

Basic components of Computer
There are 5 main computer components that are given below:
· Input Devices
· CPU
· Output Devices
· Primary Memory
· Secondary Memory
[image: computer components]
The operations of computer components are given below:
1) Inputting: 
It is the process of entering raw data, instructions and information into the computer. It is performed with the help of input devices.
2) Storing: 
The computer has primary memory and secondary storage to store data and instructions. It stores the data before sending it to CPU for processing and also stores the processed data before displaying it as output.
3) Processing: 
It is the process of converting the raw data into useful information. This process is performed by the CPU of the computer. It takes the raw data from storage, processes it and then sends back the processed data to storage.
4) Outputting: 
It is the process of presenting the processed data through output devices like monitor, printer and speakers.
5) Controlling: 
This operation is performed by the control unit that is part of CPU. The control unit ensures that all basic operations are executed in a right manner and sequence.

Input 
The data/programs/instructions which provides by the user to a system is known as input. 
Input Devices
There are different types of input devices. They are
[image: ]
1) KEYBOARD:
· A keyboard is very much like a standard typewriter keyboard with a few additional keys. The basic layout of alphabets and digits are maintained to make it easy for the trained typists to use the system. The electrical circuits just below the keys translate the characters directly into computer readable form. 
· A keyboard contains three types of keys. They are functional keys, Alpha-numeric keys and Cursor control numeric keys.
· The functional keys are used to perform some special functionality. Every functional key can perform a particular task in different software as per the task assigned to them. The functional keys are available to the top of the keyboard. The functional keys are ESC, F1 to F12.
· The Alpha-numeric keys are used to input alphabets, numbers and special symbols. The Alpha-numeric keys are available just be functional keys.
· The cursor control numeric keys are used to control the cursor and can able to input numbers. 
Advantages:
i) The keyboard is easy to use and cheap
Disadvantages:
i) The keyboard cannot be used to draw figures
ii) The process of moving the cursor to another position is very slow.







POINTING INPUT DEVICES
1) MOUSE: 
1. A mouse is an electro-mechanical, pointing device. It is used to position the cursor on the screen. 
2. It is a small palm size box.
3. The most common mouse uses an internal, magnetically coated ball, to detect the movement of the mouse across a flat surface, usually a desktop. 
4. Now a days Optical or laser mouse is used to detect the movement.  All windows based applications today are designed to work with a mouse. 
5. It can perform functions like selecting menu commands, moving icons, resizing windows, starting programs, and choosing options.
Advantages:
1. The mouse is easy to use and can be used to quickly place the cursor anywhere on the screen.
2. It also helps to quickly and easily draw figures
Disadvantages:
1. The mouse needs extra desk space to be place and moved easily
2. The ball in the mechanical mouse must be cleaned to remove dust from it.
2) Track Ball
1. It is a pointing device that is used to control the position of the cursor on the screen. 
2. It is usually used in notebook computers where it is placed on the keyboard.
3. To move the pointer, you rotate the ball with your thumb, your fingers, or the palm of your hand. There are usually one to three buttons next to the ball, which you use just like mouse buttons.
4. The advantage of trackballs over mouse is that the trackball is stationary so it does not require much space to use it. In addition, you can place a trackball on any type of surface, including your lap. For both these reasons, trackballs are popular pointing devices for portable computers.
Advantages:
1. The trackball provides better resolution
2. It occupies less space
Disadvantages:
1. The trackball chamber is often covered with dust, so it must be cleaned regularly
HANDHELD INPUT DEVICES
1) JOYSTICK: 
1) It is a handheld device. 
2) Joy stick is mostly used in playing computer games. 
3) It is a lever like device which can be moved in any direction having one or two buttons called switches. 
4) The lever of a joystick moves in all directions to control the movement of the pointer on the computer screen. 
5) A joystick is similar to a mouse, but with the mouse, the cursor stops moving as soon as you stop moving the mouse. However, in case of a joystick, the pointer continues moving in the direction to which the joystick is pointing. To stop the pointer, the user must return the joystick to its upright position.




2) STYLUS: 
1) A stylus is a pen-shaped input device used to enter information or write on the touchscreen of a handheld device.
2) It is a small stick that can also be used to draw lines on a surface as input into a device, choose an option from a menu, move the cursor to another location on the screen, take notes, and create short messages. 
3) The stylus usually slides into a slot built into the device for that purpose.
3) TOUCH SCREEN
1) A touchscreen is a display that can identify the occurrence and position of a touch inside the display region. 
2) The user can touch the screen either by using a finger or a stylus. 
3) The touchscreen facilitates the users to interact with what displayed on the screen in a straight forward manner, rather than in an indirect way by using a mouse or a touchpad. 
4) Touchscreens make using another input device redundant, since the user can interact with the screen by directly touching it. Such touchscreen displays are available on computers, laptops and mobile phones.
5) Touchscreen monitors are an easy way of entering information into the computer.
6) These days touchscreen monitors are widely used in different applications including point-of-sale (POS) cash registers, automated teller machines (ATMs), car navigation screens, mobile phones etc.
OPTICAL INPUT DEVICES
1)  BAR CODE READERS: 
Data coded in the form of light and dark lines or bars are known as bar codes.  They are used in retail trade for labeling goods and public libraries for a numbering booked. A bar code reader is used to decode bar code data. It is performed by a laser beam scanner, which is linked to a computer. The laser beam is stroked across the patterns of bits that is recorded as the input data.
Advantages:
1) Barcode readers are cheap
2) They are portable
3) They are handy and easy to use
Disadvantages:
1) Barcode readers must be handled with care. If they develop a scratch, the user may not be able to read the code.
2) They can interpret information using a limited series of thin and wide bars. To interpret other unique identifiers, the bar display area must be widened.
2) IMAGE SCANNER
1) A scanner is a device that captures images, printed text and handwriting from different sources such as photo-graphic prints, posters and magazines and converts them into digital images for editing and display on computers. 
2) Scanners come in handheld, feed-in and flatbed types and for scanning either color images, black and white images or both. 
3) Some scanners have software such as Adobe Photoshop to help the user resize or modify a capture image.
4) Some scanners can be connected to the computer using a small computer system interface (SCSI). 

A hand image scanner has to be manually moved across the object or image to be scanned. The scanner produces light from green light emitting diodes (LEDs), which high light and scan the image onto the computer for further processing. However, these days, 3D image scanners have become the most popular form of hand scanners, as they are able to compensate for jerky and then moved across a lens and sensor to capture the image.
Film scanners are usually used in photography and slides. The slide or negative film is first inserted in strips of six or less frames into the film scanner and then moved across a lens and sensor to capture the image.
Advantages:
1) Any printed or handwritten document can be scanned and stored in a computer for further processing.
2) The scanned and stored document will never deteriorate in quality with time. The document can be displayed and printed whenever required.
3) There is no fear of loss of documents. The user can scan important documents and store them permanently in the computer
Disadvantages:
1) Scanners are usually costlier than other input devices.
2) The documents that are scanned and stored as images have a higher size as compared to other equivalent text files.
3) OCR (Optical Character Reader): 
· These devices are capable of detecting alphabetic and numeric characters printed on paper. These characters can be type written or handwritten. 
· OCR devices are expensive and are used only when there are large volumes of documents to be keyed in.
4) OMR (Optical Mark Reader): 
OMR devices used to detect the presence or absence of a mark made by pencil or ink on a specially designed card or form. Such marked documents are read by a reader, which translates the marks into electrical pulses which are transmitted into computers
AUDIO VISUAL INPUT DEVICES
AUDIO INPUT DEVICES:
Audio devices are used to either capture or create sound. They enable computers to accept music, speech or sound effects for recording or editing. Microphonesare the examples of widely used audio input devices
Microphone:
1) A microphone feeds audio input to the computer. 
2) However, the audio input must be converted into digital data before being stored in the computer. For this, the computer must have a sound card. 
3) The sound card is a hardware unit that converts analogue signals generated through the microphone into digital data, so that it can be stored in the computer. 
4) When the user wants to hear the pre-recorded audio input, the sound card converts the digital data into equivalent analogue signals and sends them to the speakers. 
5) A computer with a microphone and speakers can be used to make telephone calls and do video conferencing over the internet




VIDEO INPUT DEVICES
Video input devices are used to capture video from the outside world into the computer. Here, the term video means moving picture along with sound. As we have sound cards to convert analogue audio signals into digital data and vice versa, we also have video cards to convert analogue video signals to digital data to store it in the computer. Digital camera and web camera are popular examples of video input devices.
1. DIGITAL CAMERA:
1) A digital camera is handheld and easily portable device used to capture images/videos. 
2) The digital camera digitizes images or videos and stores them on a memory card. The data can then be transferred to the computer using a cable that connects the computer to the digital camera. 
3) Once the images or video are transferred to the computer, they can be easily edited, printed or transmitted.
2. WEB CAMERA:
1) Web cameras are widely used for videoconferencing. 
2) They are very cheap, and this is one reason why they are so widely used for security and privacy purposes.
3) Webcams are also used as security cameras, since PC-connected cameras can be used to watch for movement and sound, recording both when they are detected. These recordings can then be saved in the computer and used to detect or investigate theft or any other crime. 
Advantages:
a) Audio devices can be used by people who have visual problems
b) Audio input devices are best used in situations where users want to avoid input through keyboard or mouse.
c) Video input devices are very useful for applications such as videoconferencing
d) They can also be used for security purposes.
Disadvantages:
a) Audio input devices are not effective in noisy places
b) With audio input devices, it is difficult to clearly distinguish between two similar sounding words.
OUTPUT DEVICES
The output device displays the output from the computer processing for the user. The output devices are categorized into two types. They are
1. Soft copy devices
2. Hard copy devices
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SOFT COPY DEVICES:
Soft copy output devices produce an electronic version of an output. For eg, a file that is stored on a hard disk, CD or pen drive and is displayed on the computer screen
Features:
1. The output can be viewed only when the computer is on.
2. The user can easily edit soft copy output
3. Soft copy cannot be used by people who do not have a computer
4. Searching for data in a soft copy is easy and fast.
5. Electronic distribution of material as soft copy is cheaper. It can be done easily and quickly.

a) MONITORS (CRT):
· The monitor is a soft copy output device used to display video and graphics information generated by the computer through the video card.
· It is similar to a portable television. 
· It is also known as video terminal. 
· The monitor is the most commonly used output device on the most personal computer systems.
· Monitors come in three variants such as CRT, Liquid Crystal Display (LCD) and plasma
i) CRT MONITORS:
· CRT stands for Cathode Ray Tube. 
· CRT is a technology used in traditional computer monitors and televisions. 
· The image on CRT display is created by firing electrons from the back of the tube of phosphorus located towards the front of the screen.
· Once the electron heats the phosphorus, they light up, and they are projected on a screen. The color you view on the screen is produced by a blend of red, blue and green light.
Advantages:
1. CRT monitors provide images of good quality
2. CRT monitors are cheapest when compared to LCD and plasma
3. The images are clear even when you try to view it from an angle.
Disadvantages:
1. CRT monitors occupy a large space on the desk
2. They are bigger in size and weight and therefore difficult to move from one place to another when compared with other types of monitors.
3. Power consumption is higher than the other monitors.
ii) LCD Monitor:
· An LCD monitor is a thin, flat, electronic visual display unit that uses the light modulating properties of liquid crystals, which do not emit light directly. 
· LCD screens are used in a wide range of applications ranging from computer monitors, televisions, instrument panels, aircraft cockpit displays, signage etc., to consumer devices such as video players gaming devices, clocks, watches, calculators and telephones.
· Today LCDs have become so popular that they are replacing the CRT displays at a fast pace. 
· LCD screens are more compact, lightweight, portable, more reliable and easier on the eyes. 
· LCDs are more energy efficient and offer safe disposal than CRTs. It is because of their low electrical power consumption
Advantages:
1. LCD monitors are very compact and lightweight
2. They consume less power& they are more reliable than CRTs
3. They cause less eye fatigue
Disadvantages:
1. They are more expensive than CRTs
2. Images are not very clear when tried to view from an angle.
iii) PLASMA MONITOR:
· These monitors are thin and flat monitors widely used in televisions and computers. 
· The plasma display contains two glass plates that have hundreds of thousands of tiny cells filled with xenon and neon gases. The address electrode and the transparent display electrode are sandwiched between the glass plates. The display electrode is covered by a magnesium oxide protective layer and is arranged in horizontal rows along the screen, while the address electrodes are arranged in vertical columns, thereby forming a grid-like structure.
· To ionize the gas in a particular cell, the electrodes that intersect at that cell are charged at least thousands of times within a small fraction of a second.
Advantages:
i) The technology used in plasma monitors allows producing a very wide screen using extremely thin materials.
ii) Very bright images are formed which look good from almost every angle.
iii) These monitors are not heavy and are thus easily portable.
Disadvantages:
i) These monitors are very expensive
ii) They consume much power
b) PROJECTORS:
· A project is a device that takes an image from a video source and projects it onto a screen or another surface. 
· Today projectors are used for a wide range of applications, varying from home theater systems for projecting movies and television programmes on to a screen much larger than even the biggest available television.
· Projectors also allow users to adjust some features of the image such as brightness, sharpness and color settings. 
· Projectors can be broadly classified into two categories depending on the technology they use


i) LCD Projectors
LCD projectors make use of their own light to display the image on the screen. These projectors are based on LCD technology. To use these projectors, the room must be first darkened, else the image formed will be blurred.
ii) Digital Light processing (DLP) projector:
DLP projectors use a number of mirrors to reflect the light. When using the DP projector, the room may or may not be darkened because it displays a clear image in both situations.

HARD COPY DEVICES
Hard copy output devices produce a physical form of output. For eg, the content of a file printed on paper is a form of hard copy output. 
Features:
i) A computer is not needed to see the output
ii) Editing and incorporating the edits in the hard copy is difficult
iii) Hard copy output can be easily distributed to people who do not have a computer
iv) Searching for data in a hard copy is tiring and difficult job. 
v) Distribution of a hard copy is not only costly but slow as well
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PRINTERS: 
Printers are purely output devices. They produce hard copy output. Computer printers vary widely in their technologies and capabilities. The paper copy (hard copy) obtained from a printer is called as printout or hardcopy. Printers are basically classified into two types based on the basis of the printing mechanism. They are –
1. Impact Printers
2. Non-Impact Printers
IMPACT PRINTERS
The impact printing technology uses some mechanical pressure to produce images on paper. The impact printers include dot matrix printers, line printers, band printers and daisy wheel printer. 
Advantages:
1) These printers enable the user to produce carbon copies.
2) They are cheap
Disadvantages:
1) Impact printers are slow
2) They offer poor print quality, especially in the case of graphics.
3) They can be extremely noisy




1) Dot Matrix printer: 
· It is impact printer which prints characters and images of all types as a pattern of dots.
· The print head comprises a matrix of tiny needles. They are electrically driven and print characters or image in the form of pattern of tiny dots. 
· Their speed varies from 140 to 600 cps. 
· These printers are most popular and widely used, because of their low cost.
· From 1970s to 1990s, dot matrix impact printers were the most common type of printers used with PCs
Advantages:
a) The dot matrix printer can produce carbon copies
b) It offers the lowest printing cost per page.
Disadvantages:
a) This type of printer creates a lot of noise when the pins strike the ribbon against the paper.
b) It can only print lower resolution graphics, with limited quality.
c) It is very slow and it has poor printing quality.
2) Line Printer: 
· This is a special type of impact printer work like dot matrix printer but uses a special wide print head that can print an entire line of text at one time. 
· Line printers are not high resolutions but are incredibly fast; 
· The fastest can print 3000 lines of text per minute. Because of their high speed, line printers are widely used in data centres and in industrial environments. 
3) Daisy Wheel Printer: 
· The daisy wheel printer’s wheel rotates at high speed and when the required character is positioned over the ribbon, a tiny hammer strikes it against the ribbon, thus transferring the character symbol to the paper.
· The print head of a daisy wheel printer is a circular wheel, about 3 inches in diameter with arms or spokes. The shape of the printer wheel resembles the petals of a daisy flower and hence its name. The characters are embossed at the outer ends of the arms.
4) Band Printers: 
· A band printer features a rotating band that is embossed with alphanumeric characters. To print a character, the machine rotates the band to the desired character, then a small hammer taps the band pressing the character, against a ribbon. 
· Band printers are very fast. The main advantage of using a band printer is its high speed. This type of printer can print 2000 lines per minute and is therefore, perfect for high volume printing in businesses, schools and other organizations. 
· Band printers are normally attached to mainframes and used for industrial printing. Band printers were very popular in the 1970s and 1980s.

Non-Impact Printers
These are much quieter than impact printers, as their printing heads do not strike the paper. They offer better print quality, faster printing and the ability to create prints that contain sophisticated graphics. Non-impact printers use either solid or liquid cartridge-based ink which is sprayed, dripped or electrostatically drawn on to the page. The non-impact printers are Inkjet printer and Laser printer.
Advantages:
1) Non-impact printers produce prints of good quality and hence render sophisticated graphics
2) They are noiseless
3) They are fast
4) They can print text in different fonts
Disadvantages:
      1). These printers are expensive
      2). The ink cartridges used by them are also costly
Inkjet printers:
· Inkjet is a non-impact printer and is quite when working. It sprays ink particles through its nozzle. On leaving the nozzle, the tiny particles of ink get electrically charged. The electrically charged particles are then guided on to the paper to form appropriate characters. 
· Inkjet printers are as cheap as dot matrix printers are; but their operating costs are far higher than those of dot matrix printers. However, they give much better quality than DMPs. 
· An inkjet printer can produce from 100 to several hundred pages, before ink cartridges must be replaced. There is usually one black ink cartridge and one color cartridge containing ink in primary pigments. While inkjet printers are cheaper than laser printers, they are more expensive to maintain. They are available in black and white and color.
Laser printers:
These printers speed is measures in pages per minute (PPM). These are very high- speed non-impact printers, which can produce documents at speeds of over 200 pages per minute. The technique used in these printers is called Electro – photographic technique developed from paper copier technology. Eg: Inkjet, Laser etc.
PLOTTER: 
1. A plotter is a special kind of output device that, like a printer, produces images on paper, but does so in a different way. 
2. Plotters are designed to produce large drawings or images, such as construction plans for buildings or blueprints for mechanical objects. 
3. A plotter can be connected to the port normally used by a printer. 
4. Plotters may be either pen or inkjet approach. Pen plotters are available in two forms i.e, Drum type and Flat Bed type. 
5. In drum plotters, both paper and pen move. While in flat bed plotter paper is fixed and the pen moves.


Secondary Memory
Secondary Memory or Auxiliary memory consisting of slower and less expensive device that communicates indirectly with the CPU via main memory. The Second memory stores the data and keeps it even when the power fails. It is used to store large data or programs and other information. The popular secondary storage devices are Magnetic Disks, Magnetic Tapes and compact disks.
1. MAGNETIC DISKS: 
Magnetic disks are made of rigid metals or synthetic plastic material. The disk platter is coated on both the surfaces with magnetic material and both the surfaces can be used for storage. The magnetic disk provides direct access and is popular for both small and large computer systems. The magnetic disk comes in two forms. 
a) Floppy disks  
b) Hard disks.

a) Floppy diskettes:
12. These diskettes, made of synthetic plastic material, are flexible. Hence they are called floppy diskettes or simply floppies. 
13. Floppies are cheaper and more rugged than metal disks. 
14. The floppies were introduced in the early 1970’s and became very popular with the arrival of microcomputers. 
15. The floppies are popularly used on microcomputers. 
16. They are reliable and portable. 
17. They are available in many sizes like 5¼ inches and 31/2 inches and vary in storage capacity from 360 KB to 2.88 MB. 
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b) Hard disks:
Hard disk is a metal platter with magnetic coating on both sides. Several such hard disks are stacked one on the other, without touching each other, into a disk pack for large storage. The disk pack, housed in metal container with a read/write head assembly unit, is fixed inside a computer permanently. Hard disks are highly reliable and accessing data from hard disk is faster and more efficient than that from floppies.
A disk pack is a collection of disks stacked vertically one on the other and it is mounted on a disk drive. The disk drive has a head assembly with a read/write arm for each pair of recording surfaces. Each disk has two surfaces for storage. The top surface of the first disk and the lower surface of the last disk are not used for recording because small dust particles might settle down on them. The disk drive mechanism rotates the disk pack at a constant speed. Each read/write arm has one pair of read/write head, one for each surface.
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Advantages:
i. Magnetic disks enable random access of data, which is useful for all types of real-world applications
ii. They can be used as a shared device in a multi-user environment.
iii. They are preferred for both online and offline storage of data
iv. Magnetic disks can store large amounts of data. If required, the users can have multiple disks.
v. The cost of data storage is very slow.
vi. Data transfer rate of magnetic disks is much higher than that of the magnetic tapes
Disadvantages:
i. They must be store in a dust-free environment
ii. They are larger in size and heavier in weight when compared to flash drives and optical disks.

2. Magnetic Tape: 
· Magnetic tape is serial access storage medium. 
· It can store large volume of data at low costs. 
· The conventional magnetic tape is in reels of up to 3600 feet made of Mylar plastic tape. 
· The tape is one half inch in width and is coated with magnetic material on one side. 
· The reel of tape is loaded on a magnetic tape drive unit. During any read/write operation, the tape is moved from one spool to another in the same way as in the audiocassette tape recorder. 
· The magnetic tape is densely packed with magnetic spots in frames across its width. 
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Advantages:
i. A magnetic tape is compact in size, light in weight, and can store large amounts of data. Therefore, tapes are easily portable and can be used to transfer data from one computer to another.
ii. Magnetic tapes are economical. The cost of storing characters is very less as compared to other storage devices.
iii. Copying of data on a magnetic tape is easy and fast.
iv. Magnetic tapes can be used for long-term data storage and retrieval
v. Tape drives use less power.

Disadvantages:
i. Data stored on the tape can be accessed only sequentially
ii. As compared to other storage devices, data on a tape is accessed at very slow speeds because of serial access
3. CD-ROM:
· Compact Disk is a portable secondary storage device in the shape of a round medium disk. 
· It is made of polycarbonate plastic. 
· The concept of CD was co-developed by Philips and Sony in 1982. The first CD was created on 17 August 1982 at the workshop of Philips in Germany.
· In the beginning, it was used for storing and playing sound recordings, later it was used for various purposes such as for storing documents, audio files, videos, and other data like software programs in a CD.
· A standard CD is around 5 inches in diameter and 0.05 inches in thickness. It is made of a clear polycarbonate plastic substrate, a reflective metallic layer, and a clear coating of acrylic plastic. These thin circular layers are attached one on top of another as described below:
· A polycarbonate disc layer at the bottom has the data encoded by creating lands and pits.
· The polycarbonate disc layer is coated with a thin aluminium layer that reflects the laser.
· The reflective aluminium layer is coated with a lacquer layer to prevent oxidation in order to protect the below layers. It is generally spin coated directly on the top of the reflective layer.
· The label print is applied on the lacquer layer, or artwork is screen printed on the top of the disc on the lacquer layer by offset printing or screen printing.
How Does a CD Work?
The data or information is stored or recorded or encoded in CD digitally using a laser beam that etches tiny indentations or bumps on its surface. The bump is called a pit, which represents the number 0. Space, where the bump is not created, is called land, and it represents the number 1. Thus, the data is encoded into a compact disc by creating pits (0) and lands (1). The CD players use laser technology to read the optically recorded data.
DVD:
[image: Secondary Memory]DVD is short for digital versatile disc or digital video disc. It is a type of optical media used for storing optical data. Although it has the same size as a CD, its storage capacity is much more than a CD. So, it is widely used for storing and viewing movies and to distribute software programs as they are too large to fit on a CD. DVD was co-developed by Sony, Panasonic, Philips, and Toshiba in 1995.
Types of DVDs:
DVDs can be divided into three main categories which are as follows:
· DVD-ROM (Read-Only): These types of DVDs come with media already recorded on them, such as movie dvds. As the name suggests, data on these discs cannot be erased or added, so these discs are known as a read-only or non-writable DVD.
· DVD-R (Writable): It allows you to record or write information to the DVD. However, you can write information only once as it becomes a read-only DVD once it is full.
· DVD-RW (Rewritable or Erasable): This type of discs can be erased, written, or recorded multiple times.

Pen drive:
· [image: Secondary Memory]Pen drive is a compact secondary storage device. 
· It is also known as a USB flash drive, thumb drive or a jump drive. 
· It connects to a computer via a USB port. 
· It is commonly used to store and transfer data between computers. For example, you can write a report using a computer and then copy or transfer it in the pen drive. Later, you can connect this pen drive to a computer to see or edit your report. You can also store your important documents and pictures, music, videos in the pen drive and keep it at a safe place.
· Pen drive does not have movable parts; it comprises an integrated circuit memory chip that stores the data. This chip is housed inside a plastic or aluminium casing. 
· The data storage capacity of the pen drive generally ranges from 2 GB to 128 GB. Furthermore, it is a plug and play device as you don't need additional drives, software, or hardware to use it.
Operating System
An Operating System is a set of programs that are used to manage the various resources and overall operations of the computer system.  In other words, an operating system is a program, which acts as an interface between the user and the computer.  The primary goal of Operating system is to improve the performance and efficiency of a computer system.
Functions of OS  
0. Resource Management: 
Allocation of computer resources such as memory to various jobs is done by the operating system. It manages hard disk storage, CPU, main memory and other peripheral devices.
0. Data Management: 
Operating system provides data management facilities such as data organization and retrieval from secondary storage devices. Files are created, named, read, deleted and renamed by the operating system.
0. Job Management: 
In multi-user systems, it selects new jobs for executing according to the priority fixed.
0. I/O Management: 
It manages the flow of data and instructions between the input/output devices and primary storage. It allocates and manages I/O devices. It provides I/O instructions so start printing, stop printing etc. 
0. Maintaining Security: 
Maintain security, communication of error and error control messages to the users, etc, are the other functions of the operating system.
0. Conflict resolution: 
Conflict resolution is another major function of the operating system in multi-user systems. In resolving conflict between applications, the operating system takes into account factors like critically of applications, priority of the user etc. and allocates resources accordingly.

TYPES OF OPERATING SYSTEM
1) Batch operating system
The users of a batch operating system do not interact with the computer directly. Each user prepares his job on an off-line device like punch cards and submits it to the computer operator. To speed up processing, jobs with similar needs are batched together and run as a group. The programmers leave their programs with the operator and the operator then sorts the programs with similar requirements into batches.
The problems with Batch Systems are as follows −
· Lack of interaction between the user and the job.
· CPU is often idle, because the speed of the mechanical I/O devices is slower than the CPU.
· Difficult to provide the desired priority.
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`Advantages: 
· It is very difficult to guess or know the time required by any job to complete. Processors of the batch systems knows how long the job would be when it is in queue
· Multiple users can share the batch systems
· The idle time batch system is very less
· It is easy to manage large work repeatedly in batch systems
Disadvantages: 
· The computer operators should be well known with batch systems
· Batch systems are hard to debug
· It is sometime costly
· The other jobs will have to wait for an unknown time if any job fails
2) Time-sharing operating systems
Time-sharing is a technique which enables many people, located at various terminals, to use a particular computer system at the same time. 
Time-sharing or multitasking is a logical extension of multiprogramming. Processor's time which is shared among multiple users simultaneously is termed as time-sharing.
The main difference between Multi-programmed Batch Systems and Time-Sharing Systems is that in case of Multi-programmed batch systems, the objective is to maximize processor use, whereas in Time-Sharing Systems, the objective is to minimize response time.
Multiple jobs are executed by the CPU by switching between them, but the switches occur so frequently. Thus, the user can receive an immediate response.  
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Advantages: 
· Provides the advantage of quick response.
· Avoids duplication of software.
· Reduces CPU idle time.
Disadvantages: 
· Problem of reliability.
· Question of security and integrity of user programs and data.
· Problem of data communication.
3) Distributed operating System
Distributed systems use multiple central processors to serve multiple real-time applications and multiple users. Data processing jobs are distributed among the processors accordingly.
The processors communicate with one another through various communication lines. These are referred as loosely coupled systems or distributed systems. Processors in a distributed system may vary in size and function. These processors are referred as sites, nodes, computers, and so on.
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Advantages: 
· With resource sharing facility, a user at one site may be able to use the resources available at another.
· Speedup the exchange of data with one another via electronic mail.
· If one site fails in a distributed system, the remaining sites can potentially continue operating.
· Better service to the customers.
· Reduction of the load on the host computer.
· Reduction of delays in data processing.

Disadvantages:
· Failure of the main network will stop the entire communication
· To establish distributed systems the language which are used are not well defined yet
· These types of systems are not readily available as they are very expensive. Not only that the underlying software is highly complex and not understood well yet
Examples of Distributed Operating System are- LOCUS et
4) Network operating System
A Network Operating System runs on a server and provides the server the capability to manage data, users, groups, security, applications, and other networking functions. 
The primary purpose of the network operating system is to allow shared file and printer access among multiple computers in a network, typically a local area network (LAN), a private network or to other networks.
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Advantages:
· Centralized servers are highly stable.
· Security is server managed.
· Upgrades to new technologies and hardware can be easily integrated into the system.
· Remote access to servers is possible from different locations and types of systems.
Disadvantages: 
· High cost of buying and running a server.
· Dependency on a central location for most operations.
· Regular maintenance and updates are required.
5) Real Time operating System
· These types of OSs serves the real-time systems. The time interval required to process and respond to inputs is very small. This time interval is called response time.
· Real-time systems are used when there are time requirements are very strict like missile systems, air traffic control systems, robots etc.
· There are two types of real-time operating systems.
1) Hard real-time systems
Hard real-time systems guarantee that critical tasks complete on time. In hard real-time systems, secondary storage is limited or missing and the data is stored in ROM. In these systems, virtual memory is almost never found.
2) Soft real-time systems
Soft real-time systems are less restrictive. A critical real-time task gets priority over other tasks and retains the priority until it completes. Soft real-time systems have limited utility than hard real-time systems. For example, multimedia, virtual reality, advanced Scientific Projects like undersea exploration and planetary rovers, etc.
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Advantages of RTOS:
1. Maximum Consumption: 
Maximum utilization of devices and system, thus more output from all the resources
2. Task Shifting: 
Time assigned for shifting tasks in these systems are very less. For example in older systems it takes about 10 micro seconds in shifting one task to another and in latest systems it takes 3 micro seconds.
3. Focus on Application: 
Focus on running applications and less importance to applications which are in queue.
4. Real time operating system in embedded system: 
Since size of programs are small, RTOS can also be used in embedded systems like in transport and others.
5. Error Free: These types of systems are error free.
6. Memory Allocation: Memory allocation is best managed in these type of systems.
Disadvantages of RTOS:
1. Limited Tasks: Very few task run at the same time and their concentration is very less on few applications to avoid errors.
2. Use heavy system resources: Sometimes the system resources are not so good and they are expensive as well.
3. Complex Algorithms: The algorithms are very complex and difficult for the designer to write on.
4. Device driver and interrupt signals: It needs specific device drivers and interrupt signals to response earliest to interrupts.
5. Thread Priority: It is not good to set thread priority as these systems are very less pron to switching tasks.

PROGRAMMING LANGUAGES
A programming language is a language specifically designed to express computations that can be performed by a computer. Programming languages are used to create programs that control the behavior of a system, to express algorithms, or as a mode of human communication.
The term programming language refers to high level language such as BASIC (Beginners All-purpose symbolic instruction code), C, C++, COBOL (Common Business Oriented Language), FORTRAN, ADA and PASCAL. Each of these languages has a unique set of keywords and a special syntax for organizing program instructions.
Though high-level programming languages are easy for humans to read and understand, the computer can understand only machine language, which consists of only numbers. Each type of CPU has its own unique machine language.
In between machine languages and high-level languages, there is another type of language known as assembly language. Assembly languages are similar to machine languages, but they are much easier to program because they allow a programmer to substitute names for numbers.
Generations of Programming Languages
The concept of generations of programming languages is closely connected to the advances in technology. The five generations of programming languages includemachine language, assembly language,high-level language (also known as 3GL), very high level language (also known as 4GL) and the fifth generation language that includes artificial intelligence.
1) Machine Language
· All the instructions are written in machine level language are in the form of 0’s and 1’s. 
· It is very difficult to learn and difficult to understand. This is also called as the low level language. 
· Machine language was used to program the first stored program computer system. This is the lowest level of programming language and is the only language that a computer understands. All the commands and data values are expressed using 0s and 1s, corresponding to the off and on electrical states in a computer.
· In 1950s, each computer had its own native language, and programmers had primitive systems for combining numbers to represent instructions such as add and subtract. Although there were similarities between each of the machine languages, a computer could not understand programs written in another machine language.
· The main advantage of machine language is that the execution of the code is very fast and efficient since it is directly executed by the CPU. However, on the downside, machine language is difficult to learn and is far more difficult to edit if errors occur.
Advantages:
1. Machine languages make efficient use of storage.  
2. Instructions of a machine language program are immediately executable. 
3. Program execution is faster
4. The computer can understood instructions directly and therefore no translation is needed.
Disadvantages:
1. Machine language is machine dependent
2. Code is difficult to write.
3. Code is difficult to understand by other people
4. Code is difficult to maintain.
5. It is difficult to detect and correct errors.



2) ASSEMBLY LANGUAGE
· All the instructions are written in Assembly level languages are in the form of mnemonics. Mnemonic means symbolic name. ADD for addition, MUL for multiplication, SUB for subtraction, DIV for Division etc. 
· Assembly language instructions computer cannot understand directly. So, there is a need of translator (assembler). Assembler is a system, which translate assembly level instructions into machine understandable form. 
· These languages are closely connected to machine language and the internal architecture of the computer system on which they are used. Since it is close to machine language, assembly language is also a low-level language. Nearly all computer systems have an assembly language available for use.
· Assembly language developed in the mid-1950s. It used symbolic codes, also known as mnemonic codes, which are easy-to-remember abbreviations, rather than numbers. 
· Assembly language programs consist of a series of individual statements or instructions to instruct the computer what to do. Basically, an assembly language statement consists of a label, an operation code and one or more operands.
· A symbolic program written by a programmer in assembly language is called a source program. After the source program has been converted into machine language by an assembler, it is referred to as an object program.
Advantages
1. It is easier to write programs in assembly language than in machine language.
2. It is easy to detect and correct errors
3. Assembly language programs are easier for people to modify than machine language programs
Disadvantages
1. Programs are machine dependent and thus non-portable.
2. Programmers must have a good knowledge of the hardware and internal architecture of the CPU.
3. The code cannot be directly executed by the computer
3) HIGH LEVEL LANAUGES
· All the instructions are written in High Level languages are in the form of general English. These languages are very easy to learn and easy to implement. But it also requires the translator to translate these programs into machine understandable form.
· To overcome the low level language difficulty of machine dependency, high level problem-oriented languages were developed. Such programming languages, with an extensive vocabulary of words and symbols are used to instruct a computer to carry out the necessary procedures, regardless of the type of machine being used.
· Interactive languages provide facilities for the programmer to make corrections and for changes to his program during its compilation and execution. 
· The increasing availability of mini computers and micro-computers has speeded up this process of developing languages that enable the user to obtain maximum use of the computer, without undergoing an extended period of special training or incurring the considerable post of employing a computer programmer.
Advantages:
1. The code is machine independent
2. It is easy to learn and use the language
3. There are few errors
4. It is easy to maintain the code &easy to detect and correct errors
Disadvantages:
1. Code may not be optimized
2. The code is less efficient
3. It is difficult to write a code that controls the CPU, memory and registers.

4) VERY HIGH LEVEL LANGUAGES (4GLs):
With each generation, programming languages started becoming easier to use and more similar to natural languages. 4GLs are a little different from their prior generation because they are non-procedural. While writing a code using a procedural language, the programmer has to tell the computer how a task is done – add this, compare that, do this if the condition is true, and so on- in a specific step-by-step manner.
Characteristics of 4GLs:
1. The instructions of the code are written in English like sentences
2. They are non-procedural, so users concentrate on the ‘what’ instead of the ‘how’ aspect of the task.
3. The code written in a 4GL is easy to maintain.
A typical example of a 4GL is the query language, which allows a user to request information from a database with precisely worded English-like sentences. A query language is used as a database user interface and hides the specific details of the database from the user.
5) FIFTH GENERATION PROGRAMMING LANGUAGE(5GL):
Fifth-generation programming languages are centred on solving problems using the constraints given to a program rather than using an algorithm written by a programmer. Most constraint based and logic programming languages and some declarative languages form a part of the 5GLs. These languages are widely used in artificial intelligence research. Another aspect of a 5GL is that it contains visual tools to help develop a program.
Eg: Prolog, OPS5, Mercury and VB.






















UNIT – II
Introduction to MS-Word
Microsoft Word is a word processing software package. You can use it to type letters, reports, and other documents. It gives you the ability to use your home computer as well as your business computer for desktop publishing. Earlier to Ms-word there was an application called WORDSTAR which is a CUI application and it has lot of drawbacks, to overcome those drawbacks Microsoft developed GUI application called MS-WORD.
Features of MS-Word
1. Used to prepare personal and professional letters
2. Used to design invitation cards
3. Used to design visiting cards
4. Used to format the document as per user requirement
5. Used to can check the spelling of the words in the document and also check for possible grammar.
6. Header is the text, that will be printed at the top of the every page and footer is the text that will be printed at the bottom of the page.
7. A same message can be send to different addresses is called as mail merge.
8. Very few mathematical calculations can be performed. 
9. Arranging data either in ascending order or in descending order in tables.
10. Links can be set from one page to another page using hyperlink
11. Bookmarks can be created
12. Other objects can be included in our document.
13. Mostly used for editorial purpose.
14. Security can be set for documents 
15. Used to record data by using macros
COMPONENTS OF WORD WINDOW
The components of MS-Word window are
[image: Explore Word Window]
1) File Tab
In the upper-left corner of the Word 2010 window is the File tab button. When you click the button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and perform many other tasks. 
2) Quick Access Toolbar
The Quick Access Toolbar can be find next to the File Tab button. The Quick Access toolbar provides you with access to commands you frequently use. By default Save, Undo, and Redo appear on the Quick Access toolbar. To customize this toolbar click on the dropdown arrow and select the commands you want to add.
3) Title Bar
A horizontal bar at the top of an active document is known as Title bar.  This bar displays the name of the document and application.  At the right end of the Title Bar is the Minimize, Restore and Close buttons.
4) Ribbons
The Ribbon is located near the top of the screen, below the Quick Access toolbar. You may also find a dialog box launcher in the bottom-right corner of a group.  The Ribbon makes it easier to see and find commands to format your document.  The Ribbon can be reduced to a single line of tabs by pressing CTRL + F1.
The ribbon contains three components –
· Tabs: They appear across the top of the Ribbon and contain groups of related commands such as Home, Insert, Page Layout, etc.
· Groups: They organize related commands; each group name appears below the group on the ribbon.
· Commands: Commands appear within each group as mentioned above
5) The Ruler 
The ruler is found below the Ribbon. The ruler is used to adjust paragraph margins and tab indents. You can use the ruler to change the format of your document quickly. If your ruler is not visible, follow the steps listed here:
1. Click the View tab to choose it.
2. Click the check box next to Ruler in the Show/Hide group. The ruler appears below the Ribbon. 
6) [bookmark: text]The Text Area 
Just below the ruler is a large area called the text area. You type your document in the text area. The blinking vertical line in the upper-left corner of the text area is the cursor. It marks the insertion point. As you type, your text displays at the cursor location. The horizontal line next to the cursor marks the end of the document.
7) [bookmark: bars]The Vertical and Horizontal and Vertical Scroll Bars 
The vertical and horizontal scroll bars enable you to move up, down, and across your window simply by dragging the icon located on the scroll bar. 
8) [bookmark: status]The Status Bar 
The Status bar appears at the very bottom of your window and provides such information as the current page and the number of words in your document. You can change what displays on the Status bar by right-clicking on the Status bar and selecting the options you want from the Customize Status Bar menu.  
9) Zoom Button
Zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider that you can slide left or right to zoom in or out; you can click the + buttons to increase or decrease the zoom factor.




10) View Buttons
The group of five buttons located to the left of the Zoom control, near the bottom of the screen, lets you switch through the Word's various document views.
· Print Layout view:This displays pages exactly as they will appear when printed.
· Full Screen Reading view: This gives a full screen view of the document.
· Web Layout view: This shows how a document appears when viewed by a Web browser, such as Internet Explorer.
· Outline view: This lets you work with outlines established using Word’s standard heading styles.
· Draft view: This formats text as it appears on the printed page with a few exceptions. For example, headers and footers aren't shown. Most people prefer this mode.
FILE Tab
1) New: 
This option is used to create or open a new document. The shortcut key is CTRL+N. Word Provides two types of documents. They are
1. Blank Document
It is plain and empty document where the user has to apply required styles and formats to the document. When the save this document it provides an extension of .docx

2. Template Document
It is a readymade document which contains pre-defined styles or formats these can be simply used by the user. The template document contains an extension of .dotx.
2) Open: 
This option is used to open an already existed document. The shortcut key is CTRL + O.
Steps:
1. Open Ms-Word window
Start->Programs->Ms-Office->Ms-word 2010
2. Select Open option from the File Tab button. This displays Open dialog box.
3. In the displayed dialog box specify the filename to open.
3) Save:
This option is used to save the current file as well as it is used to provide a security password to the file. The shortcut key is Ctrl +S
Steps:
1. Open Ms-Word window
Start->programs->Ms-Office->Ms-word 2010
2. Prepare a letter or any text in a document.
3. Select save option from the File Tab button. This displays SaveAs dialog box.
4. In the displayed dialog box specify the filename and to provide a password press Tools button where select General Options. This displays General options dialog box. 
5. In the displayed dialog box specify the password to open.
6. Press Save button which saves the file as well as it is password protected.



4) SaveAs
This option is used to provide another name to the existed file as well it is used to remove the password of a file.
Steps
1. Open Ms-Word window
Start->programs->Ms-Office->Ms-word 2007
2. Open a file which contains password. 
3. Select saveAs optionfrom the File Tab button. This displays SaveAs dialog box.
4. In the displayed dialog box specify the filename and to press Tools button where select General Options. This displays General options dialog box. 
5. In the displayed dialog box we can observe the password of the file. So here simply remove the password of the file and then press save button
6. This saves the file as well as it is removes the password of the file.
5) Close:
This option is used to close the file which was opened. The shortcut key is Ctrl+F4
6) Print: 
This option is used to perform the following operations.
1. Used to print all the pages of a document
2. Used to print current page of a document
3. Used to print select information of a document
4. Used to print specified range of pages
5. Used to print either odd pages or even pages in the specified range of pages.
6. Used to print number of copies 
7. It also allows the user to view the document as print preview.
7) Prepare:
1. Properties:
This allows the user view the default properties of a document as well as we can set the properties to the document. The properties can
i) Author of a document
ii) Title for the document
iii) Keywords for the document
iv) Shows Name of the document
v) Location/ path  of the document
vi) Number of pages available in a document
vii) Number of paragraphs available in a document
viii) Number of words available in a document
ix) Number of words with spaces available In a document
x) Number of editing times
HOME TAB
The Home Tab is by far the most important Tab in Microsoft Word 2007. The Home Tab contains all the commands that are used most often.  These include formatting commands like changing text size, font style, font color, list types, and clipboard functionality like Cut, Copy and Paste. Furthermore, the home tab in Word 2007 includes features like text alignment, line spacing, gallery styles and theme settings.  Finally, the Home Tab includes the ability to find and replace text. The groups on the Home Tab are as follows:
· Clipboard Group
· Font Group
· Paragraph Group
· Styles Group
· Editing Group
CLIPBOARD
This group includes popular commands like Cut, Copy and Paste.  
1. Cut:
This option is used to cut the selected text, it means you can remove a piece of text from one location and insert it into a new location in the document. The shortcut key is CTRL+X
2. Copy:
This option is used to copy the selected text or information. The shortcut key is CTRL+C
3. Paste:
This option is used to paste the information which was cut or copied. The shortcut key is CTRL+V
FONT GROUP:
1. This allows the user to change the font face
2. This allow the user to change the font sizes
3. This allows the user to change the font color
4. This allows the user to change the font styles such as bold, italic, underline, strike thru, superscript, subscript, etc
a. Bold: This changes the selected text to be bold. The shortcut key is CTRL+B
b. Italic: This changes the selected text to be italic. The shortcut key is CTRL+I
c. Underline:
This changes the selected text to be underlined. The shortcut key is CTRL+U
d. Superscript:
This allows the user to change the selected text or character as superscript.  The shortcut key is CTRL + SHIFT + +
e. Subscript:
This allows the user to change the selected text or character as subscript.  The shortcut key is CTRL + =
f. Font color:
This allows the user to change font color of a selected text.
g. Strikethru: 
This allows user to draw a line through the middle of a selected text
5. Text Affects:
This applies a visual effect to the selected text such as shadow, glow or reflection.
6. Text Highlight Color:
	This make a text look like it was marked with a highlighter pen
7. Font Size:
This allows the user to increase/decrease the font size of selected text. The shortcut key to increase font size is CTRL+} and to decrease the font size the shortcut key is CTRL+{
8. Change Case:
This allows the user to change the selected text either into upper case, lower case, toggle case or sentence case.
9. Clear Formatting:
This allows the user to clear formats which was applied on text. 




PARAGRAPH GROUP:
1) Bullets and numbering:
This allows the user to provide bullets symbols or numbering for every line or paragraph.
2) Alignment:
The alignments can be set for the information. The alignments can be left aligned, right aligned, center aligned and justification.
1) Left Alignment
By default the alignment for a document will always be left aligned. If the user wants to align left then use the shortcut key Ctrl+ L
2) Right Align:
This allows the user to align the text to be right align. The shortcut key is CTRL+R
3) Center Align
This allows the user to align the text to be center aligned. The shortcut key is CTRL+E
4) Justify:
This allows the user to align the text to be justified. The shortcut key is Ctrl + J
5) Line and Paragraph spacing:
This allows the user to specify the line spacing in between the lines. The shortcut key is Ctrl + No.
6) Shading:
This allows the user to apply background color for the selected text or paragraph
7) Borders:
This allows the user to apply borders to the selected text or paragraph
EDITING GROUP
1) Find: This option allows the user to search a specific word or phrase in a document. The shortcut key is CTRL +F
2) Replace: This option is used to replace the mis-spelled word into a correct spelled word. The shortcut key is CTRL+H
3) Select All: This option is used to select the entire information of a document. The shortcut key is CTRL+A.
4) Goto: This option is used performs the following operations
i) Used to move from one page to another
ii) Used to move from line to another
iii) Used to move from one bookmark to another
iv) Used to move from footnote to another.
		The shortcut key is CTRL+G or F5
5) Undo: This option is used to cancel the previous command. The shortcut key is CTRL + Z.
6) Redo: This option is used to cancel the undo command which was implemented previously. The shortcut key is CTRL+Y
INSERT TAB
PAGES GROUP
1. COVER PAGE: A Cover Page is used in some essays as a decorative cover or top page.  
2. BLANK PAGE: This allows the user to insert a blank page at the required position in a document.
3. PAGE BREAK: This allows the user to insert page break at the required position in a document.
TABLE GROUP
1. INSERT TABLE
This allows the user to insert a table with required number of rows and number of columns.
i) Insert row: It allows the user to insert a row in the table 
ii) Insert Column: It allows the user to insert a column in the table
iii) Delete row: It allows the user to delete a selected row of the table
iv) Delete column: It allows the user to delete a selected column of the table.
v) Split Cells: It allows the user to split a cell either into rows or columns
vi) Merge Cells: It allows the user to merge the cells into one cell.
vii) Table Styles: It allows the user to apply pre-defined styles to the selected table.
viii) Shading: It allows the user to apply shading for the selected row or column.
ix) Delete Table: This allows the user to delete the selected tabled.
2. DRAW TABLE: This allows the user to draw a table as per user requirements.
3. ERASE TABLE: This allows the user to delete the selected table.
ILLUSTRATIONS
1. PICTURE: 
This allows the user to insert pictures in the document. 
2. CLIPART: 
This allows the user to insert clipart into a document.
3. SHAPES
This allows the user to draw different shapes into a document. For these shapes we can apply different formats and styles.
4. SMARTART
Insert a SmartArt graphic to visually communicate information. SmartArt graphics range from graphical lists and process diagrams to more complex graphics, such as venn diagrams and organization charts
LINKS GROUP
1. HYPERLINK
It is used to provide a link from one file to another, it is called as hyperlink. Hyperlink is a colored and underlined text or a graphic that you click to go to a file, a location in a file. The shortcut key is Ctrl + k.
Steps:
a. Open a new file and save the file 
b. Select hyperlink option from the insert menu. This displays hyperlink dialog box. 
c. In the displayed dialog box specify the address or URL of a file to which link should provide.
2. BOOKMARK
A location or selection of text that you name for reference purposes. Word marks the location with the name you specify. Bookmarks are more than placeholders. These Bookmarks allow the user to easily navigate from one bookmark to another.
HEADER AND FOOTER GROUP
1. HEADER AND FOOTER
A header or footer is text or graphics such as a page number, the date, or a company logo that is usually printed at the top or bottom of each page in a document. A header is printed in the top margin; footer is printed in the bottom margin.
2. PAGE NUMBER
This option is used to insert page numbers either at the bottom of a page or at the top of the page. The page numbers can be 1,2,3 (or) I,II,II (or) A,B,C or a,b,c etc.
TEXT GROUP  
1. TEXT BOX
This allows the user to design text box in the document. The textbox can also be formatted. Within the textbox we can add the text.
2. WORD ART: It is used to insert decorative text in a document.
3. DROP CAP
This option is used to drop required number of lines under a selected character.
4. AUTO TEXT
A storage location for text or graphics you want to use again for example, a mailing address you use often, a standard contract clause, or a long distribution list for memos. 
Steps
1. Type the text and select the text for which you want to create AutoText
2. Select new option of the AutoText from insert menu. This displays a new dialog box. In the displayed dialog box specify the name
5. DATE AND TIME
It is used to insert date and time. The shortcut key is to insert date is ALT+ SHIFT + D and the shortcut key to insert time is ALT+SHIFT+T
6. OBJECT
This option is used to insert other applications or objects into our document and then can be edited when required in its respective applications and this can be called as Object Linking and embedding
Steps:
1. Open a new blank document
2. Select object option from the insert menu. This displays a object dialog box.
3. In the displayed dialog box select the required object which you want to insert on a work sheet. This opens that object where we can write or edit the data of the object it can be called as object Linking and embedding.
SYMBOLS GROUP 
1. Equation
The Equation tool is an easy way to add mathematical expressions to your document. It allows you to create your own equation from scratch.
2. Symbol
The Symbol tool allows you to type characters not usually found via the keyboard.
PAGE LAYOUT TAB
THEMES GROUP
[bookmark: themes]Themes is a great feature if you are typing an elaborate document and want to use a variety of fonts and colors and then duplicating those fonts and colors on another document or throughout a long document. A document theme is a set of formatting choices that include a set of theme colors, a set of theme fonts that you can specify a heading and body text font, and a set of theme effects you can choose lines and fill effects.
You will get a list of pre-designed themes you can apply to your document. Each theme will include font colors, font styles, font sizes and effects including lines, fill effects, and colors.
PAGE SETUP GROUP
1. Margins:
This allows the user either to select the margin sizes for the entire document or the current section. The Margins displays the list of the pre-defined margin sizes margins. When you want to change the margins for a document select custom margins from the page setup group, this displays margins dialog box. In the displayed dialog box change the top, bottom, right, and left margins.
2. Orientation
The Orientation button lets you choose which direction your document will print either Portrait or Landscape.
3. Columns:
The Columns button is great for newspapers and newsletters. This feature will break your document up into as many columns as you would like.  
4. Size
The Size button allows the user to change the size of the page. The size of the page can be Legal, Tabloid, A4, A3, Letter size, etc.  
5. Breaks:
Break gives you the option to format different sections of your document separately. You can insert page breaks or section breaks. If you would like one page with columns and another without this is the feature you would use by inserting a page break.
Page Background
1. Watermark
The Watermark button gives you a list of default watermarks you can put in your document. To use the default features simply scroll through the options with the side scroll bar then click on the selection you would like to place in your document. 
2. Page Color:
This allows the user to apply background color for a document.
3. Page Borders:
This allows the user to apply page borders and shadings for a document.
PARAGRAPH GROUP
This Paragraph section is broken up into two parts, Indent and Spacing.
1. Indent:
· Indent Left moves in the paragraph by the amount you type in the dialog box or you can change it with the up and down arrows. 
· Indent Right moves in the right side of the paragraph.
2. Spacing:
· Before Spacing: This allows the user to add spacing before the paragraph begins
· After Spacing: This allows the user to add spacing after the paragraph begins
ARRANGE GROUP
The buttons in Arrange are used mostly for arranging pictures or objects on your page. Therefore the Align button will be the only button available to you unless you have a picture or object on your Word document. 
1. Position:
The Position button allows you to position a graphic or object like a chart on a page with your text. The default selections will place your picture either top, center or bottom of the page both vertically and horizontally. 
2. Bring Forward and Send Backward 
Bring to Front and Send to Back are for layering objects and pictures on your page. To use the Bring to Front button you need to select the graphic you want to move and click the button. This will bring the Picture in front of all the other pictures it is with and they will overlap.
3. Text Wrapping
Text wrapping is similar to Position. Position places the graphic on the page in relation to the text, Top, Bottom, or Center. Text Wrapping gives you options on how you want the text to wrap around your picture or object. 


4. Align
The top 3 options Align Left, Align Center, and Align Right will align your text horizontally on the page. The next 3 will align your text vertically on the page. Distribute Horizontally and Distribute Vertically are useful when you want to fill an entire page. Highlight your whole document then click either Distribute Horizontally or Vertically. 
5. Group
Group lets you select several items by clicking on them and holding the ctrl key click on another object so multiple objects are selected then click group to make them all one. This allows you to move all objects at the same time like they were one.
6. Rotate
Rotate lets you select a picture or object and rotate it clockwise or counter clock wise, flip it vertical or horizontal or if you select More Rotation Options you can pick how many degrees you want the object rotated so you can have objects at any angle you choose.
REFERENCES TAB
1. TABLE OF CONTENTS
Once your report is finished, you would click on the table of contents drop down arrow and select your style. This will create your table of contents page automatically. It may even go through your document and automatically add content. This is the easiest way to add a table of contents.
2. Footnote and Endnote
You can include both footnotes and endnotes in the same document. You might use footnotes for detailed comments and endnotes for citation of sources. Footnotes appear at the end of each page in a document. Endnotes typically appear at the end of a document.
MAILINGS GROUP
1. Envelops
When the envelopes and labels window opens notice you have a place to enter your delivery address and Return address. To create a single envelope type the address you would like for the recipient and your return address and click the Print button. Make sure you have your envelope loaded in your printer before you click print.  
2. Mail Merge
Mail Merge is a powerful tool for writing and sending a personalized letter or e-mail to many different people at the same time. You can also use it to create envelopes or labels with each recipient' information. Mail Merge imports data from another source such as Excel and then uses that data to replace placeholders throughout your message with the relevant information for each individual you are messaging. You can use it to quickly create personalized messages for hundreds of people at once
Steps
1. Click on the Mailings tab, then the Start Mail Merge button, and then select Step by Step Mail Merge Wizard
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2. The wizard will open in the task pane to the right of the document as
[image: ]
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3. Select your document type as letters and then Click Next: Starting document from the bottom of the task pane. You will then be prompted to select a starting document. 
[image: ]
4. Choose a document you currently have displayed in the main Word window, start from a template, or choose an existing document file and then click on Next Select recipients from the bottom of the task pane.  
[image: ]
5. You will then be prompted to select your mail merge recipients.  You can choose an existing list, use your Outlook mail contacts, or type a new list.  
6. Choose Type a new list option and press create button, this displays a new address list dialog box where we should enter all recipients addresses and then press next button this displays saveas dialog box where we have to specify the name for the file.
7. This displays Mail Merge Recipients dialog box. Here press ok button.
8. On the current document window we can observe mail merge tool bar where select Insert Merge Field button, here we can observe the fields list, select each field and place it on a document at a required place.
[image: ]
9. Select Preview Result button from the mailings tab ribbon, this changes the field names into respective address.
10. If we want to display all the letters at a time press Finish & Merge button from mailings tab ribbon where select Edit Individual Documents options, this displays a dialog box whereselect “All” option and then press ok button. This displays all the letters at a time.
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REVIEW TAB
1. PROOFING GROUP
a. SPELLING AND GRAMMAR
This allows the user to check spellings if any spelling mistakes available it suggests the correct spellings so that we can replace if required.

This also checks the grammatical mistakes and rectifies by providing suggestions. The shortcut key isF7.
b. THESAURUS:
This allows the user to find the meanings of the selected words. The shortcut key is shift + F7
c. WORD COUNT:
This option performs the following operations. They are
i. It counts the number of paragraphs available in a document
ii. It counts the number of pages available in a document
iii. It counts the number of lines available in a document
iv. It counts the number of words available in a document
v. It counts the number of characters available in a document
d. Research
The Research button opens a pane that you can search through references materials such as dictionaries and encyclopedias. Click the Research button to play with the options a little.
2. LANGUAGE GROUP
1. Translate
The translate button will Translate selected text into another language. After selecting your text and clicking the translate button you will get a pane similar to the other buttons in this section so you can choose the language.

3. COMMENTS GROUP
The Word 2010 comments section lets someone add a comment to your document. The comments work like sticky notes. 
1. New Comment
Click the New Comment button you will see a line that goes from the section of the document your cursor is to the edge of the page. You can also highlight sections of text for your reference comment. Once you have inserted your comment click in the comment box and type your note.
2. Delete
The Delete button gives you 3 choices. You can delete the selected comment, delete all comments shown, or delete all comments in the document.
Using the Previous and Next buttons you can scroll through each comment quickly. 
VIEW TAB
1. Document views
a. Print Layout 
When you click on the Print Layout button in the Document Views section this will change the view of the document you are working on to look just like the document will print.
b. Full Screen Reading
It changes the view of the document to a larger view that takes up most of the screen and removes the buttons at the top to maximize the view for easy reading and editing. If you choose this view click the close button at the top right corner to return to the normal view.
c. Web Layout
The Web Layout button will change the view of the document to appear as it would if the pages were turned into a web page.
d. Outline View:
The outline button will show your document as an outline then give you another tab with more outlining tools. 
e. Draft 
The Draft, will give you a chance to view your document as a draft for quick editing. This view removes elements of the document such as headers and footers for easy editing.
2. Zoom: 
This option is used to magnify the document as per our requirement.
3. Macro
A macro is a series of commands and instructions that you group together as a single command to accomplish a task automatically.
Steps:
1. Open a new blank document
2. Select Record Macro option from the Macros group from the view tab. This displays Record Macro dialog box.





[image: Word 2007 Record Macro window]








3. In the displayed dialog box specify the macro name and then select the keyboard button. This displays customized keyboard dialog box where we have to assign the shortcut key.
4. Now start recording the information and perform required commands.
5. Stop the recording
6. Once a macro is recorded you can run it when required by pressing the shortcut key.
Editing Macro:
To Edit macro the following steps to be followed.
1) From the view Tab, select Macros option where select View Macros option. 
2) This displays Macros dialog box. In the displayed dialog box select the macro name and press Edit button.
3) This opens a code window where we can observe the recorded data and if we want to do any changes on it change it and press ALT + Q to return to word document.
4) Now run the macro either by shortcut key assigned or simple go through view->macros->view Macros->select macro name and press run button.
Deleting Macro:
To delete macro,
1. View->Macros-> View Macros ->Select Macro name and press delete button.
2. This deletes the macro selected.















UNIT - III
Introduction of MS-EXCEL:
MS-EXCEL is an application of MS-Office. It is mostly used to perform accounting / financial calculations. Earlier to MS-Excel there was an application called LOTUS-123 which is a Character User Interface. LOTUS-123 contains so many drawbacks, to overcome the drawback of LOTUS-123, Microsoft Corporation developed an interactive Graphical User Interface application called MS-Excel. It is an electronic spreadsheet.
Features of MS-EXCEL
1. It is used to prepare financial statements
2. It is used to perform any type of calculations.
3. It is used to design graphs to find the up and downs of organization.
4. It is used to apply different formats on the list.
5. It is used to maintain database very easily and effectively.
6. It is used to filter the list.
7. It is used to perform auditing.
8. It is used to perform goal seek operation.
9. It is used to record the data and it can be played when required to the user.
10.  It is used to arrange the data either in ascending or descending order.
11. It is used to create scenarios which means in a cell or row we can enter group of values by defining the names.
12. It is used to provide validations either on a row or column.
13. Used to format the data as per user requirement.
14. Used to prepare custom list.
15. Used to prepare pivot table report
16. Used to provide security on a spreadsheet.
spreadsheet
A combination of rows and columns is called as spreadsheet. MS-Excel 2007 contains 1048576 rows, and 16,384 columns.
Workbook
A collection of spreadsheets is called as workbook. A work book by default contains 3 spreadsheets. When we save a workbook by default it contains .xlsx extension
Cell
It is defined as an intersection of rows and columns
EXCEL WINDOW COMPONENTS:
[image: Explore Excel Window]
1) File Tab
In the upper-left corner of the Excel 2010 window is the File Tab. When you click the File tab, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and perform many other tasks. 
2) Quick Access Toolbar
The Quick Access Toolbar can be find next to the File Tab. The Quick Access toolbar provides you with access to commands you frequently use. By default Save, Undo, and Redo appear on the Quick Access toolbar. To customize this toolbar click on the dropdown arrow and select the commands you want to add.
3) Title Bar
A horizontal bar at the top of an active document is known as Title bar.  This bar displays the name of the document and application.  At the right end of the Title Bar is the Minimize, Restore and Close buttons.
4) Ribbon
The Ribbon is located near the top of the screen, below the Quick Access toolbar. You may also find a dialog box launcher in the bottom-right corner of a group.  The Ribbon makes it easier to see and find commands to format your document.  The Ribbon can be reduced to a single line of tabs by pressing CTRL + F1.
The ribbon contains three components −
1) Tabs: They appear across the top of the Ribbon and contain groups of related commands such as Home, Insert, Page Layout etc.
2) Groups: They organize related commands; each group name appears below the group on the Ribbon. For example, a group of commands related to fonts or a group of commands related to alignment, etc.
3) Commands: Commands appear within each group as mentioned above.
5) Help
The Help Icon can be used to get excel related help anytime you like. This provides nice tutorial on various subjects related to excel.
6) Zoom Control
Zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider that you can slide left or right to zoom in or out. The + buttons can be clicked to increase or decrease the zoom factor.
7) View Buttons
The group of three buttons located to the left of the Zoom control, near the bottom of the screen, lets you switch among excel's various sheet views.
· Normal Layout view − This displays the page in normal view.
· Page Layout view − This displays pages exactly as they will appear when printed. This gives a full screen look of the document.
· Page Break view − This shows a preview of where pages will break when printed.
8) Sheet Area
The area where you enter data. The flashing vertical bar is called the insertion point and it represents the location where text will appear when you type.
9) Row Bar
Rows are numbered from 1 onwards and keeps on increasing as you keep entering data. Maximum limit is 1,048,576 rows.
10) Column Bar
Columns are numbered from A onwards and keeps on increasing as you keep entering data. After Z, it will start the series of AA, AB and so on. Maximum limit is 16,384 columns.

11) Status Bar
This displays the current status of the active cell in the worksheet. A cell can be in either of the four states 
(a) Ready mode which indicates that the worksheet is ready to accept user input
(b) Edit mode indicates that cell is editing mode, if it is not activated the you can activate editing mode by double-clicking on a cell 
(c) A cell enters into Enter mode when a user types data into a cell 
(d) Point mode triggers when a formula is being entered using a cell reference by mouse pointing or the arrow keys on the keyboard.
12) Dialog Box Launcher
This appears as a very small arrow in the lower-right corner of many groups on the Ribbon. Clicking this button opens a dialog box or task pane that provides more options about the group.
Operator 
An operator is nothing but symbols which are used to operate the operands. Excel support different types of operators. They are
1. Arithmetic Operators
2. Relational / Comparison operators
3. String Operators
Arithmetic Operators 
The arithmetic operators are used to perform arithmetic operations, Such as addition, Subtraction, multiplication and division. The arithmetic operators are
	Operator 
	Meaning 

	+
	Addition

	-
	Subtraction

	*
	Multiplication

	/
	Division

	^
	Exponential


Relational / Comparison Operators 
The Relational operators are used to compare the operands. The relational operators are 
	Operator 
	Meaning 

	>
	Greater than

	<
	Less than

	>=
	Greater than equals to 

	<=
	Less than equals to

	==
	equals to 

	!=
	not equals to 


String Operators: 
This operator is used to combine two or more strings into one.
	Operator 
	Meaning 

	&
	Concatenate



STEPS TO ENTER FORMULA IN EXCEL
1. In a formula cell specify equals to operator 
2. Followed to equals to operator specify the cell name 
3. Followed to cell name specify the arithmetic operator and then cell name.
Syntax: = cell name <operator> cell name
CELL REFERENCE
A reference identifies a cell or a range of cells on a worksheet and tells where to look for the values or data you want to use in a formula. With references, you can use data contained in different parts of a worksheet in one formula or use the value from one cell in several formulas. You can also refer to cells on other sheets in the same workbook, to other workbooks, and to data in other programs. References to cells in other workbooks are called “external references”. References to data in other programs are called “remote references”.

Cell references are often used in formulas to calculate values stored in the worksheet. Cell references are of different types. They are 
1. Relative Reference
2. Absolute  Reference
3. Mixed Reference

1. Relative Reference
By default, Excel cell references are relative references. Whenever a formula is copied from one part of the worksheet to the other, the address of the cell changes, relative to the row or column into which the formula is copied. This ability to change the formula to match the location where you copy it is called Relative referencing or Relative Addressing. The formula is always adjusted relative to its location. 
Eg:
By default, Excel uses relative reference. See the formula in cell D2 below. Cell D2 references (points to) cell B2 and cell C2. Both references are relative.
[image: Relative Reference Example]
Steps
1. Select cell D2, click on the lower right corner of cell D2 and drag it down to cell D5.
[image: Relative Reference Result]
Cell D3 references cell B3 and cell C3. Cell D4 references cell B4 and cell C4. Cell D5 references cell B5 and cell C5. In other words: each cell references its two neighbors on the left.
2. ABSOLUTE REFERENCE
An absolute reference is a cell reference that does not change when you copy or move a formula. To create an absolute reference, Insert dollar sign ($) in front of each column letter and row number, like this =$B$5. You can copy this formula to any cell, and it will always reference cell B5. Thus, in absolute referencing, both row and column are fixed.
Steps:
1. To create an absolute reference to cell H3, place a $ symbol in front of the column letter and row number of cell H3 ($H$3) in the formula of cell E3.
[image: Absolute Reference Example]
2. Now we can quickly drag this formula to the other cells.
[image: Absolute Reference Result]
The reference to cell H3 is fixed (when we drag the formula down and across). As a result, the correct lengths and widths in inches are calculated.
3. Mixed Reference:
Mixed Reference is a combination of relative and absolute reference. That is, one part of the cell address is absolute and the other is relative. For example, in $B5 the column is absolute but the row is relative. Therefore, if you copy the formula ($B5) across the screen, it remains unaltered. Whereas if you copy the formula vertically, the row number automatically changes. Similarly in B$5, the column letter is relative but the row number is absolute.
Types of functions in Excel
Excel contains different types of pre-defined functions. They are
1. Numeric Functions
2. String Functions
3. Aggregate / Statistical functions
4. Logical functions
5. Date and Time functions
6. Financial functions
	Numeric
	String
	Aggregate
	Logical
	Date and Time
	Financial

	Abs()
	Upper( )
	Sum( )
	If( )
	Today( )
	Pvt()

	Sqrt()
	Lower( )
	Average()
	And( )
	Now( )
	Fv()

	Product()
	Proper( )
	Count( )
	Or( )
	Date( )
	

	Power()
	Left( )
	Max( )
	Not( )
	Day( )
	

	Round()
	Right( )
	Min( )
	
	Month( )
	

	Ceiling()
	Length( )
	
	
	Year( )
	

	Floor()
	Concatenate()
	
	
	Time( )
	

	Sin()
	Mid( )
	
	
	Hour( )
	

	Cos()
	
	
	
	Minutes( )
	

	Tan()
	
	
	
	Seconds( )
	

	Mod()
	
	
	
	
	


NUMERIC FUNCTIONS:
1. abs(): This function is used to convert negative value to positive value.
Syntax: abs(No.)
		Eg: =abs(100-120) => 20
2. Sqrt(): This function returns the square root of a given number.	
Syntax:sqrt(No.)
		Eg: =Sqrt(81) => 9
			  = Sqrt(abs(-81)) => 9
3. mod(): This function returns the modulus (remainder) after dividing a number.
Syntax: mod(dividend, divisor)
Eg: =Mod(10,3)=>1
4. Product(): This function returns the product of given values.
Syntax: product(n1,n2,n3,….)
	Eg: =product(1,2,3,4,5)=120
5. Round(): This function is used to round off the required number of decimals.
Syntax:Round(no, no. of decimals)
Eg: =Round(45.6789,2) =>45.68
=Round(45.6789,1) =>45.7
=Round(45.6789,0) =>46
6. Ceiling(): This function returns the nearest highest integer value.
		Syntax:Ceiling(no, significant no.)
		Eg: =Ceiling(56.124,1) => 57
7. Floor(): This function returns the nearest lowest integer value.
		Syntax:Floor(no, significant no.)
		Eg: =Floor(56.9999,1) => 56
8. sin(),cos(),tan(): These functions returns the trignometrical values of given angles.
Syntax:  Sin (       )
	 Cos ( No)
	Tan (      )
Eg:Sin(90)=>1
9. Power(): This function returns the power of a specified raised number.
Syntax:power(N, raised no.)
Eg: =power(5,4) =>625
STRING FUNCTIONS:
1. Upper(): This function is used to convert a string into upper case.
Syntax:upper(“string”)
Eg: =upper(“hello”) => HELLO
2. Lower(): This function is used to convert a string into lower case.
Syntax:lower(“string”)
Eg:  =lower(“HELLO”) => hello
3. Proper(): This function is used to convert a string into initial caps.
Syntax:proper(“string”)
Eg: =proper(“computer education”)
		Computer Education
4. Left(): 
This function is used to get the specified number of characters from the left side of a string.
Syntax:left(“string”,length)
Eg: =left(“computer”,5) =>Compu
5. Right: 
This function is used to get the specified number of characters from the right side of a string.
	Syntax:right(“string”,length)
	Eg: =right(“computer”,5)=>puter
6. Length(): This function returns the length of  a given string.
Syntax:length(“string”)
Eg: =length(“computer”) => 8
7. Concatenate(): This function is used to combine two strings into one.
Syntax:concatenate(“string1”,”string2”)
Eg: =concatenate(“hello”,”world”) =>Helloworld
8. Mid(): 
This function is used to get specified number of characters as per specification.
Syntax:mid(“string”,startingpos,length)
Eg: =mid(“computer education”,10,3)    =>edu
AGGREGATE FUNCTIONS:
1. Sum(): This function is used to calculate of specified number of values.
Syntax:sum(n1,n2,n3,…..)
Eg: =sum(1,2,3,4,5) =>15
2. Average(): This function is used to calculate average of specified number of values.
Syntax:average(n1,n2,n3,…..)
	Eg: =average(1,2,3,4,5) =>3
3. Count(): This function is used to count list of values available.
Syntax:count(n1,n2,n3,…..)
	Eg: =count(1,2,3,a,b,4,5) =>5
4. Max(): This function returns maximum value from specified number of values.
Syntax:max(n1,n2,n3,…..)
Eg: =max(1,2,43,4,5) =>43

5. Min(): This function returns the minimum value from specified number of values.
Syntax:Min(n1,n2,n3……)
Eg: =Min(12,34,3,354,34,36)=>3
Logical functions:
1. if(): 
This function returns true value if the given condition is true otherwise it returns false result.
Syn: =if(condition, true result , false result)
Eg: = if(20>5,”A is Big”, “ B is big”) 
2. and():
This logical function should be used along with if() logical function. The and() logical function is used to combine two or more conditions into one and all the conditions which specified in and()  are true means, then only it returns true result otherwise it returns false result.
Syn: =if(and(condition1,condition2,….),”true result”,”false result”)
Eg: Create a statement to calculate student results
3 Subject Marks			Avg			Grade
>=35				>=75			Distinction
>=35			>=60 and <75		First
>=35			>=50 and <60		Second
>=35			>=35 and <50		Third
        -				---			Fail
	Rno
	Name
	M1
	M2
	M3
	Total
	Average
	Grade

	101
	Raju
	67
	6
	67
	
	
	

	102
	Sikander
	67
	69
	88
	
	
	

	103
	Tony
	77
	66
	87
	
	
	

	104
	Akbar
	55
	44
	54
	
	
	

	105
	Arvind
	45
	34
	67
	
	
	

	106
	Ravinder
	45
	47
	48
	
	
	


Total (F2)
	=sum(c2:e2)
Average (G2)
	=average(c2:e2)
Grade (H2)
=if(and(c2>=35,d2>=35,e2>=35,g2>=75),”Distinction”,  
if(and(c2>=35,d2>=35,e2>=35,g2>=60,g2<75),”First”, 
if(and(c2>=35,d2>=35,e2>=35,g2>=50,g2<60),”Second”, 
if(and(c2>=35,d2>=35,e2>=35,g2>=35,g2<50),”Third”,”Fail”))))	
	Rno
	Name
	M1
	M2
	M3
	Total
	Average
	Grade

	101
	Raju
	67
	6
	67
	140
	46.666
	Fail

	102
	Sikander
	67
	69
	88
	224
	74.666
	First

	103
	Tony
	77
	66
	87
	230
	76.666
	Distinction

	104
	Akbar
	55
	44
	54
	153
	51
	Second

	105
	Arvind
	45
	34
	67
	146
	48.666
	Third

	106
	Ravinder
	45
	47
	48
	140
	46.666
	Third




3. or():
This logical function should be used along with if() logical function. The or()  logical function is used to combine two or more conditions into one and all the conditions or any one condition which specified in or()  are true means, then only it returns true result otherwise it returns false result.

	Syn:	=if(or(condition1,condition2,….),”true result”,”false result”)

4. Not(): 
This logical function should be used along with if() logical function. The not() logical function returns true if the condition is false otherwise it returns true result.

	Syn: =if(not(condition1,condition2,….),”true result”,”false result”)
Date Functions:
1. Today(): This function returns the system date.
Eg: =today() =>6/6/2023
2. Now(): This function returns both the date and time.
Eg: =now() =>6/6/2023 8:30
3. hour(): This function returns the hour of a specified time.
Syn:hour(time)
Eg: =hour(10:20) =>10
4. minute(): This function returns the minutes of a specified time.
Syn:minutes(time)
Eg: = minutes(10:20) =>20
5. Second(): This function returns the seconds of a specified time.
Syn:seconds(time)
Eg:seconds(10:20:13) =>13
6. day(): This function returns the day of a specified date.
Syn:day(date)
Eg: =day(today()) =>6
7. month(): This function returns the month of a specified date.
Syn:month(date)
Eg: =month(today()) => 9

HOME TAB
The Home Tab in Microsoft Excel 2007 has a lot of functionalities.  You can do things like formatting, alignment, inserting and deleting rows or columns, sorting and filtering numbers, applying styles and formatting effects, finding and replacing data and much more using the Tab. The Home Tab has the following groups that you can utilize: 
· Clipboard Group
· Font Group
· Alignment Group
· Number Group
· Styles Group
· Cells Group
· Editing Group

1. Clipboard Group:
Clipboard is the group and it has commonly used commands like Cut, Copy and Paste.  Using these commands you can remove text from one area of your Microsoft Excel sheet to another.  When you use the Cut option, it removes the source text.  However when you use Copy option, it leaves the source text in place.  Using the Paste command, you can then insert the clipboard text into the new location.  
a. Cut: This option is used to cut the selected text, it means you can remove a piece of text from one location and insert it into a new location in the document. The shortcut key is CTRL+X
b. Copy: This option is used to copy the selected text or information. The shortcut key is CTRL+C
c. Paste:This option is used to paste the information which was cut or copied. The shortcut key is CTRL+V
2. Font Group:
a. This allows the user to change the font face
b. This allow the user to change the font sizes
c. This allows the user to change the font color
d. Bold: This changes the selected text to be bold. The shortcut key is CTRL+B
e. Italic: This changes the selected text to be italic. The shortcut key is CTRL+I
f. Underline: This changes the selected text to be underlined. The shortcut key is CTRL+U
g. Superscript: This allows the user to change the selected text or character as superscript.  The shortcut key is CTRL+SHIFT+ +
h. Subscript: This allows the user to change the selected text or character as subscript.  The shortcut key is CTRL + =
i. Font color: This allows the user to change font color of a selected text.
j. Fill Color: This allows the user to change the background color for a selected cell.
k. Strikethru: This allows user to draw a line through the middle of a selected text
l. Font Size: This allows the user to increase/decrease the font size of selected text. The shortcut key to increase font size is CTRL+} and to decrease the font size the shortcut key is CTRL+ { 
m. Change Case: This allows the user to change the selected text either into upper case, lower case, toggle case or sentence case.
3. ALIGNMENT GROUP
· The alignment group allows the user to change alignment of a selected cell. The alignment can be top, left, middle, bottom, right and center.
a) Orientation: It also allows the user to rotate the selected data as per our requirement.
b) Wrap Text: It also allows the user to wrap the text within a cell
c) Merge and Center: It also allows the user to join two or more cells into one and then centers the contents the new cell
4. NUMBER GROUP:
This group allows the user to change the format of selected data. The format can be number, currency, accounting, date, time, text and fraction.


5. STYLES GROUP
1. Conditional Formatting:
Using conditional formatting, you can highlight your data using a combination of color scales, icon sets, and data bars.  This will translate into a visual understanding off the underlying data that you are trying to analyze.   
Steps:
i) Open a new Workbook
ii) Select a row/column on which conditional formatting has to apply.
iii) Select Conditional formatting from the Styles group. This displays conditional formatting dialog box. 
iv) In the displayed dialog box specify the condition and specify the formats for which the formats should apply when the given condition is true.
2. Format table: This allows the user to change the format of a selected table.
3. Cell Styles: This allows the user to change the style of a selected cell.
6. CELLS GROUP:
1. Insert Cells: This allows the user to insert a cell, column or row.
2. Delete Cells: This allows the user to delete a cell, row or column
3. Delete Sheet: This allows the user to delete a sheet.
4. Format: This allows the user to change the row height, column width, organize sheets, protect sheet or hide cells.
7. Editing Groups:
1. Find and Select
1. Find: This option allows the user to search a specific word or phrase in a document. The shortcut key is CTRL +F
2. Replace: This option is used to replace the mis-spelled word into a correct spelled word. The shortcut key is CTRL+H
3. Select All: This option is used to select the entire information of a document. The shortcut key is CTRL+A.
4. Go to: This option is used performs the following operations
i. Used to move from one page to another
ii. Used to move from line to another
iii. Used to move from one bookmark to another
iv. Used to move from footnote to another.
			The shortcut key is CTRL+G or F5
INSERT TAB
The Insert Tab in Microsoft Excel 2007 will let you add external objects in your workbook.  You can insert things pictures, clip art images, smart art graphics, charts, Pivot tables, hyperlinks, header and footer sections, etc using this Tab. 
1. Tables Group
2. Illustrations Group
3. Charts Group
4. Text Group
1. TABLES GROUP
1) Pivot Table
PivotTable report is an interactive table that quickly combines and compares large amounts of data. You can rotate its rows and columns to see different summaries of the source data, and you can display the details for areas of interest
Steps:
1. Create a list in a spread sheet
2. Open the workbook where you want to create the PivotTable report.
3. On the Data menu, click PivotTable and PivotChart Report.
4. In step 1 of the PivotTable and PivotChart Wizard, follow the instructions, and click PivotTable under What kind of report do you want to create?
5. Follow the instructions in step 2 of the wizard.
6. Follow the instructions in step 3 of the wizard, and then decide whether to layout the report onscreen or in the wizard.
Usually you can layout the report on screen, and this method is recommended. Use the wizard to layout the report only if you expect retrieval from a large external data source to be slow, or you need to set page fields to retrieve data one page at a time. If you aren't sure, try laying out the report onscreen. You can return to the wizard if necessary.
2. ILLUSTRATIONS GROUP
1. PICTURE: This allows the user to insert pictures in the document. 
2. CLIPART: This allows the user to insert clipart into a document.
3. SHAPES
This allows the user to draw different shapes into a document. For these shapes we can apply different formats and styles.
4. SMARTART
Insert a SmartArt graphic to visually communicate information. SmartArt graphics range from graphical lists and process diagrams to more complex graphics, such as Venn diagrams and organization charts
CHART
The graphs or charts are used to design the graphs for the list to find the up and downs of organization. Graph is interactive, and clearly represents the data of the list. 
Components of Charts:
[image: A typical column chart containing a variety of standard chart elements.]
1. Chart area: 
Everything inside the chart window, including all parts of the chart (labels, axes, data markers, tick marks, and other elements listed here).
2. Data marker: 
A symbol on the chart that represents a single value in the worksheet. A data marker (or data point) may be a bar in a bar chart, a pie slice in a pie chart, or a line on a line chart. Data markers with the same shape or pattern represent a single data series in the chart.
3. Chart data series: 
A group of related values, such as all the values in a single row in the chart. A chart can have just one data series (shown in a single bar or line), but it usually has several.
4. Axis: 
A line that serves as a major reference for plotting data in a chart. In two-dimensional charts there are two axes — the x-axis (horizontal/category) and the y-axis (vertical/value). In most two-dimensional charts (except column charts), Excel plots categories (labels) along the x-axis and values (numbers) along the y-axis. Bar charts reverse the scheme, plotting values along the y-axis. Pie charts have no axes. Three-dimensional charts have an x-axis, a y-axis, and a z-axis. The x– and y-axes delineate the horizontal surface of the chart. The z-axis is the vertical axis, showing the depth of the third dimension in the chart.
5. Tick mark: 
A small line intersecting an axis. A tick mark indicates a category, scale, or chart data series. A tick mark can have a label attached.
6. Plot area: 
The area where Excel plots your data, including the axes and all markers that represent data points
7. Gridlines: 
Optional lines extending from the tick marks across the plot area, thus making it easier to view the data values represented by the tick marks
8. Chart text: 
A label or title that you add to the chart. Attached text is a title or label linked to an axis such as the Chart Title, Vertical Axis Title, and Horizontal Axis Title that you can’t move independently of the chart. Unattached text is text that you add with the Text Box command button on the Insert tab of the Ribbon.
9. Legend: 
A key that identifies patterns, colors, or symbols associated with the markers of a chart data series. The legend shows the data series name corresponding to each data marker  
Steps to create Graph 
1. Open a new worksheet
2. Create a list in a spread sheet
3. Keep the cell pointer in a list and then select chart option from the insert tab of charts group. This displays chart wizard, where select the type of chart to design and then press next button, this prompts the user to select the range of list for which a graph should design and then press next button this shows the preview of graph and it prompts the user to either the graph should display as separate object or in the same worksheet.
4. The graph/ chart which designed can be formatted. By this we can easily find the up and downs of organization very easily and effectively.




Types of Graphs:
Excel provides you different types of charts that suit your purpose. Based on the type of data, you can create a chart. Excel offers the following major chart types −
1. Column Chart
2. Line Chart
3. Pie Chart
4. Doughnut Chart
5. Bar Chart
6. Area Chart
7. XY (Scatter) Chart
8. Bubble Chart
1) Column Chart
A Column Chart typically displays the categories along the horizontal (category) axis and values along the vertical (value) axis. To create a column chart, arrange the data in columns or rows on the worksheet. A column chart has the following sub-types −
· Clustered Column.
· Stacked Column.
· 100% Stacked Column.
· 3-D Clustered Column.
· 3-D Stacked Column.
· 3-D 100% Stacked Column.
· 3-D Column.
2) Line Chart
Line charts can show continuous data over time on an evenly scaled Axis. Therefore, they are ideal for showing trends in data at equal intervals, such as months, quarters or years. 
In a Line chart −
· Category data is distributed evenly along the horizontal axis.
· Value data is distributed evenly along the vertical axis.
To create a Line chart, arrange the data in columns or rows on the worksheet. A Line chart has the following sub-types −
· Line
· Stacked Line
· 100% Stacked Line
· Line with Markers
· Stacked Line with Markers
· 100% Stacked Line with Markers
· 3-D Line
3) Pie Chart
Pie charts show the size of items in one data series, proportional to the sum of the items. The data points in a pie chart are shown as a percentage of the whole pie. To create a Pie Chart, arrange the data in one column or row on the worksheet. A Pie Chart has the following sub-types −
· Pie
· 3-D Pie
· Pie of Pie
· Bar of Pie
4) Doughnut Chart
A Doughnut chart shows the relationship of parts to a whole. It is similar to a Pie Chart with the only difference that a Doughnut Chart can contain more than one data series, whereas, a Pie Chart can contain only one data series.

A Doughnut Chart contains rings and each ring representing one data series. To create a Doughnut Chart, arrange the data in columns or rows on a worksheet.
5) Bar Chart
Bar Charts illustrate comparisons among individual items. In a Bar Chart, the categories are organized along the vertical axis and the values are organized along the horizontal axis. To create a Bar Chart, arrange the data in columns or rows on the Worksheet.
A Bar Chart has the following sub-types −
· Clustered Bar
· Stacked Bar
· 100% Stacked Bar
· 3-D Clustered Bar
· 3-D Stacked Bar
· 3-D 100% Stacked Bar
6) Area Chart
Area Charts can be used to plot the change over time and draw attention to the total value across a trend. By showing the sum of the plotted values, an area chart also shows the relationship of parts to a whole. To create an Area Chart, arrange the data in columns or rows on the worksheet. An Area Chart has the following sub-types −
· Area
· Stacked Area
· 100% Stacked Area
· 3-D Area
· 3-D Stacked Area
· 3-D 100% Stacked Area
7) XY (Scatter) Chart
XY (Scatter) charts are typically used for showing and comparing numeric values, like scientific, statistical, and engineering data. A Scatter chart has two Value Axes −
· Horizontal (x) Value Axis
· Vertical (y) Value Axis

It combines x and y values into single data points and displays them in irregular intervals, or clusters. To create a Scatter chart, arrange the data in columns and rows on the worksheet. Place the x values in one row or column, and then enter the corresponding y values in the adjacent rows or columns.

A Scatter chart has the following sub-types −
· Scatter
· Scatter with Smooth Lines and Markers
· Scatter with Smooth Lines
· Scatter with Straight Lines and Markers
· Scatter with Straight Lines




3. LINKS GROUP
1. HYPERLINK
It is used to provide a link from one file to another, it is called as hyperlink. Hyperlink is a colored and underlined text or a graphic that you click to go to a file, a location in a file. The shortcut key is Ctrl + k.
Steps:
i. Open a new file and save the file 
ii. Select hyperlink option from the insert menu. This displays hyperlink dialog box. 
iii. In the displayed dialog box specify the address or URL of a file to which link should provide.
4. TEXT GROUP
a. Header and Footer
A header or footer is text or graphics such as a page number, the date, or a company logo that is usually printed at the top or bottom of each page in a document. A header is printed in the top margin; footer is printed in the bottom margin.
b. Text Box
This allows the user to design text box in the document. The textbox can also be formatted. Within the textbox we can add the text.
c. Word Art:  It is used to insert decorative text in a document.
d. OBJECT
This option is used to insert other applications or objects into our document and then can be edited when required in its respective applications and this can be called as Object Linking and embedding
Steps:
1. Open a new blank document
2. Select object option from the text group of insert tab. This displays an object dialog box.
3. In the displayed dialog box select the required object which you want to insert on a work sheet. This opens that object where we can write or edit the data of the object it can be called as object Linking and embedding.
5. SYMBOLS GROUPS
1. Equation:
The Equation tool is an easy way to add mathematical expressions to your document. It allows you to create your own equation from scratch.
2. Symbol
The Symbol tool allows you to type characters not usually found via the keyboard.
PAGE LAYOUT TAB
1. THEMES GROUP
Themes is a great feature if you are typing an elaborate document and want to use a variety of fonts and colors and then duplicating those fonts and colors on another document or throughout a long document. A document theme is a set of formatting choices that include a set of theme colors, a set of theme fonts that you can specify a heading and body text font, and a set of theme effects you can choose lines and fill effects.
You will get a list of pre-designed themes you can apply to your document. Each theme will include font colors, font styles, font sizes and effects including lines, fill effects, and colors.
If you already selected a theme for your document and no longer want to use it click on the Reset to Theme from Template option. 
2. PAGE SETUP GROUP
1. Margins:
This allows the user either to select the margin sizes for the entire document or the current section. The Margins displays the list of the pre-defined margin sizes margins. 
When you want to change the margins for a document select custom margins from the page setup group, this displays margins dialog box. In the displayed dialog box change the top, bottom, right, and left margins.
2. Orientation
The Orientation button lets you choose which direction your document will print either Portrait or Landscape.
3. Size
The Size button allows the user to change the size of the page. The size of the page can be Legal, Tabloid, A4, A3, Letter size, etc.  
4. Breaks:
Break gives you the option to format different sections of your document separately. You can insert page breaks or section breaks. If you would like one page with columns and another without this is the feature you would use by inserting a page break.
5. Background: This allows the user to change the background of a spreadsheet.  

3. ARRANGE GROUP
The buttons in Arrange are used mostly for arranging pictures or objects on your page. Therefore the Align button will be the only button available to you unless you have a picture or object on your Word document. 
1. Bring Forward and Send Backward 
Bring to Front and Send to Back are for layering objects and pictures on your page. To use the Bring to Front button you need to select the graphic you want to move and click the button. This will bring the Picture in front of all the other pictures it is with and they will overlap.
2. Align
The top 3 options Align Left, Align Center, and Align Right will align your text horizontally on the page. The next 3 will align your text vertically on the page. Distribute Horizontally and Distribute Vertically are useful when you want to fill an entire page. Highlight your whole document then click either Distribute Horizontally or Vertically. 
3. Group
Group lets you select several items by clicking on them and holding the ctrl key click on another object so multiple objects are selected then click group to make them all one. This allows you to move all objects at the same time like they were one.
4. Rotate
Rotate lets you select a picture or object and rotate it clockwise or counter clock wise, flip it vertical or horizontal or if you select More Rotation Options you can pick how many degrees you want the object rotated so you can have objects at any angle you choose.



FORMULAS TAB
1. Auditing
Auditing is used to trace arrow marks from where the results are extracted. Auditing can be performed by using different options. Such as trace precedents, trace dependents, trace errors and remove all arrows.
1. Trace precedents:
This option is used to trace arrow marks from where the results are extracted.
2. Trace dependents:
This option is used to trace arrow marks from which cell the result is dependent.
3. Trace errors:
This option is used to trace arrow marks from which cells the error is occurred.
4. Remove all arrows:
This option is used to remove all arrows which were traced by using different options.
DATA TAB
1. Sort and Filter
1. Sort: This option is used to arrange the list either in ascending or descending order.
2. Auto Filter: This option is used to display required data from the given list. 
Steps
1. Create a list in a Spread sheet
2. Select the headings of list and select the filter option from the Data tab. This displays drop down arrow buttons on headings of the list.
3. Press the displayed drop down button and select the required data to be displayed.
3. Advanced Filter
This option is used to display required data from the given list in other part of sheet.
Steps
1. create a list in a spread sheet
2. Select the headings and copy them on other part of worksheet
3. Specify the condition 
4. Select the advanced filter option from data menu. This displays the advanced filter dialog box
[image: ]
5. In the displayed dialog box, specify the list range, criteria range and then specify range to copy data. This displays the list of specified condition.
2. Data Tools Group
1. Text to Columns: This option is used to divide the text into columns.
2. Validations: This option allows the user to accept valid data into a cell, row or column otherwise it raises an error message.
Steps:
1. Open a worksheet
2. Select row or column
3. Select validation option from data tab. This displays validations dialog box.
4. In the displayed dialog box specify the required validation or condition and error alert if required.
5. Now in a selected row or column we can only store valid data.
What-If-Analysis
The real power in Excel comes in its ability to perform multiple mathematical calculations for you. One of the tools in Excel that you can use to perform these calculations is a data tool called What-If Analysis. What-If-Analysis allows you to see the effect that different values have in formulas.

Three kinds of What-If Analysis tools come with Excel: scenarios, data tables and Goal seek. Scenarios and data tables take sets of input values and determine possible results. A data table works only with one or two variables. A scenario can have multiple variables, but it can accommodate only up to 32 values. Goal seek works differently from scenarios and data tables in that it takes a result and determines possible input values that produce that result.
In addition to these three tools, you can install add-ins that help you perform what-if analysis, such as the solver add-in. The solver add-in is similar to Goal seek, but it can accommodate more variables.
1. Goal seek
The Goal seek method is to find a specific value for a cell by adjusting the value of one other cell. When goal seeking, Excel varies the value in a cell that you specify until a formula that’s dependent on that cell returns the result you want. Microsoft excel varies the value in one specific cell until a formula that’s’ dependent on that cell returns the result you want.
Steps:
1. Create a list and implement formula for calculating result
2. Keep the cell pointer on a formula cell and select goal seek option from the tools menu. This displays goal seek dialog box.
[image: ]
3. In the displayed dialog box, we can observe cell name at set cell, specify the value to value to achieve that result and specify the cell name which cell value has to change.
4. This achieves the target value which is required.
2. SCENARIOS
A named set of input values that you can substitute in a row or column. A scenario is a set of values that Microsoft Excel saves and can substitute automatically in your worksheet. You can use scenarios to forecast the outcome of a worksheet model. You can create and save different groups of values on a worksheet and then switch to any of these new scenarios to view different results.
Steps
1. Select scenarios option from Data tools group of Data Tab. This displays scenario manager dialog box.
[image: ]
2. In the displayed Scenario manager dialog box press the add button this displays Add Scenario dialog box. Specify scenario name and specify changing cells which should be changed.
[image: ]
3. In the displayed Add Scenario dialog box specify the values to change.
4. After creating scenarios select scenario and press show button to display its respective values.





3. Data Table
A data table is a range of cells that shows how changing one or two variables in your formulas will affect the results of those formulas. Data tables provide a shortcut for calculating multiple results in one operation and a way to view and compare the results of all the different variations together on your worksheet.
You can create one-variable or two-variable data tables, depending on the number of variables and formulas that you want to test.
ONE-VARIABLE DATA TABLES    
Use a one-variable data table if you want to see how different values of one variable in one or more formulas will change the results of those formulas. 
For example, you can use a one-variable data table to see how different interest rates affect a monthly mortgage payment by using the PMT function. You enter the variable values in one column or row, and the outcomes are displayed in an adjacent column or row.
TWO-VARIABLE DATA TABLES  
Use a two-variable data table to see how different values of two variables in one formula will change the results of that formula. 
For example, you can use a two-variable data table to see how different combinations of interest rates and loan terms will affect a monthly mortgage payment.

3. OUTLINE GROUP
1. SUBTOTAL
The sub totals option is used to calculate sub totals of the list, while calculating sub-totals first arrange the list in ascending order.
Steps
1. Create a list in spread sheet
2. Arrange the list either in ascending or descending order based on which sub-totals should calculate.
3. On the Data menu, click Subtotals. This displays subtotal dialog box. In the displayed dialog box, at each change in box, click the column to subtotal. 
4. In the Use function box, click the summary function you want to use to calculate the subtotals. 
5. In the Add subtotal to box, select the check box for each column that contains values you want to subtotal.   
6. If you want an automatic page break after each subtotal, select the Page break between groups check box. 
7. If you want the subtotals to appear above the subtotaled rows instead of below, clear the Summary below data check box. Click OK. 
REVIEW TAB
1. PROOFING GROUP
1) SPELLING AND GRAMMAR
This allows the user to check spellings if any spelling mistakes available it suggests the correct spellings so that we can replace if required.
This also checks the grammatical mistakes and rectifies by providing suggestions. The shortcut key is F7.


2) Thesaurus:
This allows the user to find the meanings of the selected words. The shortcut key is shift + F7
3) Word Count:
This option performs the following operations. They are
1. It counts the number of paragraphs available in a doc.
2. It counts the number of pages available in a document
3. It counts the number of lines available in a document
4. It counts the number of words available in a document
5. It counts the number of characters available in a document
4) Research
The Research button opens a pane that you can search through references materials such as dictionaries and encyclopedias. Click the Research button to play with the options a little.
2. Language Group
1. Translate
The translate button will Translate selected text into another language. After selecting your text and clicking the translate button you will get a pane similar to the other buttons in this section so you can choose the language.
2. COMMENTS GROUP
The Word 2007 comments section lets someone add a comment to your document. The comments work like sticky notes. 
1) New Comment
Click the New Comment button you will see a line that goes from the section of the document your cursor is to the edge of the page. You can also highlight sections of text for your reference comment. Once you have inserted your comment click in the comment box and type your note.
2) Delete
The Delete button gives you 3 choices. You can delete the selected comment, delete all comments shown, or delete all comments in the document. Using the Previous and Next buttons you can scroll through each comment quickly. 
VIEW TAB
1. WORKBOOK VIEWS
1) Normal  
This allows the user to view the document in a normal view. By default the view of the document will be normal view.  
2) Page Layout 
It allows the user to view the document as it will appear on the printed page. Use this view to see where pages begin and end and to view any headers or footers on the page.  
3) Page break preview
It allows the user to view a preview of where pages will break when this document is printed.
4) Full Screen: It views the document in full screen mode.



2. Macro Group
1. Macros
A macro is a series of commands and instructions that you group together as a single command to accomplish a task automatically.
Steps:
1. Open a new workbook
2. Select Record Macro option from the Macros group from the view tab. This displays Record Macro dialog box.
3. In the displayed dialog box specify the macro name and shortcut key.
4. Now start recording the information and perform required commands.
5. Stop the recording
6. Once a macro is recorded you can run it when required by pressing the shortcut key or click on View tab -> Macros-> Macros name ->run. 
Note:
Once a macro is recorded you will need to make the developer ribbon available to make any changes or work with your macro.
Editing Macro:
To Edit macro the following steps to be followed.
1. From the view Tab, select Macros option where select View Macros option. 
2. This displays Macros dialog box. In the displayed dialog box select the macro name and press Edit button.
3. This opens a code window where we can observe the recorded data and if we want to do any changes on it change it and press ALT + Q to return to word document.
4. Now run the macro either by shortcut key assigned or simple go through view->macros->view Macros->select macro name and press run button.
Deleting Macro:
To delete macro,
1) View->Macros-> View Macros ->Select Macro name and press delete button.
2) This deletes the macro selected.













Unit – IV
Introduction to Microsoft Powerpoint
Microsoft PowerPoint is a software program developed by Microsoft to produce effective presentations. It is a part of Microsoft Office suite. The program comprises slides and various tools like word processing, drawing, graphing and outlining. Thus it can display text, table, chart, graphics and media in the slides.By default, documents saved in PowerPoint 2010 are saved with the .pptx extension whereas, the file extension of the prior PowerPoint versions is .ppt.
Features of Powerpoint
There are multiple features that are available in MS PowerPoint which can customise and optimise a presentation.
1. Slide Layout
Multiple options and layouts are available based on which a presentation can be created. 
2. Insert – Clipart, Video, Audio, etc.
Under the “Insert” category, multiple options are available where one can choose what feature they want to insert in their presentation. This may include images, audio, video, header, footer, symbols, shapes, etc. 
3. Slide Design
MS PowerPoint has various themes using which background colour and designs or textures can be added to a slide. This makes the presentation more colourful and attracts the attention of the people looking at it.
4. Animations
During the slide show, the slides appear on the screen one after the other. In case, one wants to add some animations to the way in which a slide presents itself, they can refer to the “Animations” category. 
5. Clean Up Tables Quickly
Data tables in PowerPoint are one of the most effective ways to present data. They're easy for your viewer to quickly glance at and understand numbers with an easy row-column view. 
6. Set Slide Sizes
To change slide size, go to the Design tab and choose to change the slide size from the Customize dropdown:
7. Rearrange Slides for Effectiveness
Most presentations can become markedly better in just a few seconds by simply rethinking the order that your slides are sequenced. Over and over, I coach presenters to remember the BLUF principle: bottom line up front.
8. Use Slide Master View to Update Designs Consistently
Most of my favorite PowerPoint features not only save time, but also ensure that slides are consistent. .









Components of powerpoint window

[image: Explore PowerPoint]
1) File Tab
This tab opens the Backstage view which basically allows you to manage the file and settings in PowerPoint. You can save presentations, open existing ones and create new presentations based on blank or predefined templates. The other file related operations can also be executed from this view.
2) Ribbon
The Ribbon is located near the top of the screen, below the Quick Access toolbar. You may also find a dialog box launcher in the bottom-right corner of a group.  The Ribbon makes it easier to see and find commands to format your document.  The Ribbon can be reduced to a single line of tabs by pressing CTRL + F1.
The ribbon contains three components −
· Tabs: They appear across the top of the Ribbon and contain groups of related commands such as Home, Insert, Page Layout etc.
· Groups: They organize related commands; each group name appears below the group on the Ribbon. 
· Commands: Commands appear within each group as mentioned above.
3) Title Bar
This is the top section of the window. It shows the name of the file followed by the name of the program which in this case is Microsoft PowerPoint.
4) Slide Area
This is the area where the actual slide is created and edited. You can add, edit and delete text, images, shapes and multimedia in this section.
5) Help
The Help Icon can be used to get PowerPoint related help anytime you need. Clicking on the "?" opens the PowerPoint Help window where you have a list of common topics to browse from. You can also search for specific topics from the search bar at the top.
6) Zoom Options
The zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider that you can slide left or right to zoom in or out, you can click on the - and + buttons to increase or decrease the zoom factor. The maximum zoom supported by PowerPoint is 400% and the 100% is indicated by the mark in the middle.
7) Slide Views
The group of four buttons located to the left of the Zoom control, near the bottom of the screen, lets you switch between PowerPoint views.
· Normal Layout view − This displays page in normal view with the slide on the right and a list of thumbnails to the left. This view allows you to edit individual slides and also rearrange them.
· Slide Sorter view − This displays all the slides as a matrix. This view only allows you to rearrange the slides but not edit the contents of each slide.
· Reading View − This view is like a slideshow with access to the Windows task bar in case you need to switch windows. However, like the slideshow you cannot edit anything in this view.
8) Quick Access Toolbar
The Quick Access Toolbar is located just under the ribbon. This toolbar offers a convenient place to group the most commonly used commands in PowerPoint. You can customize this toolbar to suit your needs.
9) Slide Tab
This section is available only in the Normal view. It displays all the slides in sequence. You can add, delete and reorder slides from this section.
Creation of a Presentation
1. When you open PowerPoint window by default a slide appears. The slide has two placeholders or text boxes. Additional text boxes can be added from the Insert tab.
2. To start creating presentation click on the placeholder or text box a blinking cursor will appear. Then type the title and click outside the box. The text box will disappear.
Auto Content Wizard 
· This wizard is useful for certain categories of presentations particularly business related presentations. It Provides templates and ideas for a wide variety of different types of presentation
· PowerPoint will create a number of slides for you and will suggest content relevant to that specific type of presentation.
· This wizard helps you determine the content and organisation of your presentation by using an outline.
· The AutoContent Wizard leads you through a series of questions so you can choose the best layout for your presentation.
Steps to create auto content Wizard:
1) Step to start
Select (File > New) to display the New Presentation task pane and click on the AutoContent Wizard hyperlink. This will ask you for some information such as your name, the tile of the presentation, type of the presentation. This wizard only creates an outline for common types of presentations.
	[image: https://bettersolutions.com/powerpoint/presentations/autocontentwizard-start.png]


2) Select the presentation type: 
Select the type of presentation you want that best describes the type of presentation you are going to give.There are several sub topics to choose from under each category. There are a number of different categories to choose from or you can choose All to display the entire list.
	[image: https://bettersolutions.com/powerpoint/presentations/autocontentwizard-presentationtype.png]


3) Step 3 - Presentation Style
Choose the type of output you want for the presentation.
	[image: https://bettersolutions.com/powerpoint/presentations/autocontentwizard-presentationstyle.png]


4) Step 5 - Presentation Options
Enter a presentation title and footer
	[image: https://bettersolutions.com/powerpoint/presentations/autocontentwizard-presentationoptions.png]


5) Step 6 - Finish
Select Finish to view the presentation.
	[image: https://bettersolutions.com/powerpoint/presentations/autocontentwizard-finish.png]


 
Saving a Presentation
There are multiple options to save a presentation. The frequently used options are:
· Click on the File tab then select Save or Save As from the menu.
· This displays Save As dialog box where specify the filename and the press save button, this saves file
Adding a Slide
There are multiple ways to add slide in PowerPoint presentation. They are 
1) Using Office Themes to add slide:
· Select the slide next to which you want the new slide to appear
· In Home tab, click the drop-down arrow on the New Slide button
· It will display the office themes
· Select the slide choice that suits your requirement
2) Using Duplicate Selected Slide option to add slide:
· Select the slide you want to duplicate
· In Home tab, click the drop-down arrow of New Slide button
· Left click the Duplicate Selected Slide
3) Using Reuse Slides option to add slide:
· Select the slide next to which you want the new slide to appear
· In Home tab, click the drop-down arrow of New Slide button
· Select the Reuse Slides option
· Click on Browse then click on Browse File
· Select the slide from the presentation that you want to import

Deleting and existing slides from the presentation
There are times while building a slide deck, you may need to delete some slides. This can be done easily from PowerPoint. You can delete the slides from the Normal view as well as the Slide Sorter view. In each view, you can delete the slides in two ways.
1) Deleting from Normal View
· Go to the Normal view.
· Right-click on the slide to be deleted and select the Delete Slide option.
2) Deleting from Slide Sorter View
· Go to the Slide Sorter view.
· Right-click on the slide to be deleted and select the Delete Slide option.
Note: 
Alternately, you can select the slide and press the Delete button on your key board.

Inserting Picture and Clip Art
To Add Picture:
· Click the Insert tab
· In Illustrations group click on the Picture button
· Insert Picture dialogue box appears
· With a click select the desired picture
· Click Insert, the picture will be added to the slide
· Click and drag the picture to move it to desired location
To Add Picture:
· Click the Insert tab
· In Illustrations group click the Clip Art button
· Clip Art task pane appears on the right side
· In task pane you will notice three fields: Search for, Search in, Results should be
Editing Picture and Clip Art
· Select the Picture or Clip Art that you want to edit
· Format tab appears in the Ribbon next to View tab
· It displays four groups of commands; Adjust, Picture Styles, Arrange and Size group
The Adjust group displays six commands.
· Brightness: To increase and decrease the picture brightness
· Picture Contrast: To increase or decrease the picture contrast
· Recolor: To recolor the picture to give it special effect
· Compress Picture: To compress picture to reduce its size
· Change Picture: To change the picture
· Reset Picture: To discard all the changes made to the picture
The Picture Styles group displays picture styles and three commands.
· Picture Styles: To apply a picture style to the picture or clip art
· Picture Shape: To change the shape of the picture or clip art
· Picture Border: To give colors to the picture border
· Picture Effects: To apply visual effect to the picture
The Arrange group has six commands:
· Bring to Front: To bring the picture in front of all other objects
· Send to Back: To send the picture behind other objects
· Selection Pane: It displays selection pane with various options to format and change order of picture
· Align: To align the multiple pictures on the slide. You can distribute them evenly across the slide.
· Group: To group different objects together
· Rotate: To rotate the text or objects
The Size group has three commands.
· Crop: To remove unwanted parts of the picture
· Height: To change the height of the picture
· Width: To change the width of the picture
Steps to Apply Animation Effect
· Select the text or object you want to animate
· Select the Animations tab
· In Animations group click the drop-down arrow next to Animate option
· Animation options will appear
· Move the cursor over different options to see live preview on the slide
· Select the desired animation
Steps to Apply a Custom Animation Effect
· Select the text or object
· Select the Animation tab
· In Animation group click the Custom Animation
· Custom Animation task pane appears on the right
· Click the Add Effect, it will display four options that are further divided into different options
· Select the desired effect
Steps to Apply Slide Transition Effects
Transition effects appear when one slide changes into next slide in a Slide Show
· Select the slide to which you want to apply the effect
· Select the Animation tab
· In Transition to This Slide group you will see the transition effects
· Click the drop-down arrow to see menu of transition effects
· Select the desired transition effect
· Click Apply To All to apply the effect to all slides
Steps to Insert Table
· Place the cursor on the slide where you want to insert the table
· Click the Insert tab, it will display Tables group on the left
· Click the Table button, it will display four options to insert the table:
1) Highlight the Number of Rows and Columns
You will see small boxes on top, select the boxes corresponding to number of rows and column that you want in your table.
2) Insert Table
Click the Insert Table option and enter the number of rows and columns then click ok.
3) Draw Table
Click the Draw Table option and place the cursor on slide. Cursor changes into a pencil. Click and drag the pencil to draw a table border.
4) Excel Spreadsheet:
Click the Excel Spreadsheet option. Worksheet will appear in the slide, drag it to get the desired number of rows and columns.
Steps to run slide show
Most PowerPoint presentations are created to be run as a slideshow. Most of these features are really to help you create a good slideshow without having to go through the entire presentation over and over again after every minor change. Features related to running the slideshow are grouped under the Slideshow ribbon.
	Section
	Menu Item
	Description

	Start Slideshow
	From Beginning
	Starts slideshow from beginning

	
	From Current Slide
	Starts slideshow from the current slide

	
	Broadcast Slideshow
	Allows users to broadcast the slideshows using Microsoft's PowerPoint Broadcast Service

	
	Custom Slideshow
	Builds a custom slideshow by picking the slides you want to run

	Set Up
	Set Up Slideshow
	Helps set up the slideshow including browser/ full screen display, show options with or without narration/ animation, pen and laser color during the slideshow and the slides to be presented during the show

	
	Hide Slide
	Helps mark/ unmark the slide as hidden, so it is skipped or shown during the slideshow respectively

	
	Rehearse Timing
	Allows users to rehearse the timing on each slide and the entire slideshow

	
	Record Slideshow
	Records the slideshow including narration and animation

	
	Slideshow Checkboxes
	Helps set or avoid the use of narrative audio and rehearsed timings during the show. Display media controls in the slideshow view

	Monitors
	Resolution
	Defines resolution in slideshow view

	
	Show Presentation on
	Picks the monitor to display the presentation one - in case of multiple monitors

	
	Use Presenter View
	Run presentation in Presenter view rather than just slideshow view


Steps to Insert Chart
· Select the Insert tab
· In Illustrations group click on Chart command
· An Insert Chart dialogue box appears
· Select the desired Chart style and click Ok
· Chart will be added to slide and an Excel worksheet appears on right side of the slide
Steps to View Slides
Once you create the presentation you can view it in different ways. Select the View tab, locate the Presentation Views group. It displays four options to view presentations; Normal View, Slide Sorter View, Slide Show View and Notes Page View.
1. Normal View:
The normal view appears by default when we open the PowerPoint window. We create and edit slides in Normal View. This view also offers three view options out of four options in the form of buttons on the status bar.
2. Slide Sorter View: 
It offers miniature or thumbnail version of all slides. You can see all your slides at one time in the screen. You can also drag or delete the slides to rearrange them.
3. Slide Show View: 
It displays your presentation in full screen mode. It also offers an additional menu at the left bottom corner of the slide.
4. Notes Page View
This view provides space below the slide to add notes.



















Unit – V
Introduction to MS-Access:
MS-Access is an application of MS-office. MS-Access is RDBMS          (Relational Database Management System). Earlier to MS-Access there was a database called FOXPRO and DBASE-III which are DBMS products. The DBMS product contains some drawbacks such as data redundancy, data isolation, security etc. To overcome these drawbacks E.F.Codd’s introduced RDBMS. E.F. Codd’s introduced 12 rules based on Relational Algebraic Theory and if any database supports at least 6 rules then that product can be a RDBMS.
Features of MS-ACCESS
MS-Access provides number of features to the user to maintain database, to design applications very easily and effectively.
1. Used to create database objects (Tables, queries, forms, reports)
2. Used to enter the data into tables very easily and effectively.
3. Used to modify the database objects very easily
4. Used to set constraints or rules on the columns of a table.
5. Used to delete the rows of a table when they are not required.
6. Used to update the data of a table very easily.
7. Used to create/ design the forms.
8. Used to design the reports
9. Used to extract the required data from the table.
10. Used to provide relations from one table to another.
Database
A collection of inter-related records is called as a database.
Record
A collection of fields is called as a record.
Field 
A collection of characters is called as a field.
Database objects
Access stores all the data tables and other objects in a single database. These database objects are Queries, Forms, Reports and Macros. 
1) Tables:
A table is a database object. Table can be defined as a collection of rows and columns. In a table we can add rows, modify rows and rows can also be deleted.
2) Queries: 
You use a query to extract information from a database.  A query can select a group of records that fulfill a certain condition.  
3) Reports:
Reports present your data in a printed format. You can create different types of reports with a DBMS.  
4) Forms: 
Forms display and print data from a table or a query. Forms enable you to view, edit and print data in a custom format. Data-entry forms help users to enter information into a database table in an easy and accurate manner. Data-entry and display forms provide a more structured view of the data as compared to a datasheet. From this structured view, you can add, change, delete or view database records. 


5) Relationships
Relationships are the links or connections, which are formedbetween the one or more tables in the database. There exist following four types of relationships:
· One-to-One Relationship
· One-to-Many Relationship
· Many-to-One Relationship
· Many-to-Many Relationship
6) Macros
Macros are used for performing the repetitive tasks on reports and forms in the MS Access database. It also allows the user for adding functionalities to forms, controls, and reports.
7) Modules
Modules are used to perform the automating routine operations and user-defined functions which are written in VBA. Any user can easily use these modules from anywhere in the MS Access database.
Datatypes in MS-Access
A data type can be defined as the type of values to be accepted. Ms-Access supports different types of datatypes.  They are
	Data Type
	Type of Data Stored
	Storage Size

	Text 
	Alphanumeric characters
	2billions of characters

	Memo 
	Alphanumeric characters
	0-64,000 characters

	Number 
	Numeric values
1. byte
2. integer
3. long integer


4. single
5. double
6. Auto number
	
0 to 255
-32768 to +32767
-2,147,483,648 
         To
+2,147,483,647
3.4*10-38 to 3.4*10+37
1.7*10-308 to 1.7*10+307
Automatic number sequence

	Date/Time
	Date and time data
	8 bytes

	Currency 
	Monetary data
	8 bytes

	Logical type
	Yes/No, True/False
	1 bit (0 or -1)

	OLE Object
	Pictures, graphs, sound, video
	Up to 1 GB

	Lookup Wizard
	Displays data from another table
	Generally 4 bytes


Steps to create database in MS-ACCESS
1) Open MS-Access window
2) When we open MS-Access window it displays a dialog box where select Blank database and specify the name/Filename for database.
3) Press create button. This creates a database.
Steps to create table
The table can be easily created in the MS Access database by the following two ways:
1. Using Datasheet View
2. Using the Design View
Creating table using Datasheet View
When you create a new database, then the MS Access automatically creates a new table for you in the datasheet view
Steps:
· Select the Create tab in the toolbar of MS Access.
· click on the Table, in the Tables group.
· After clicking, a default table is opened in the datasheet view  
· When the table has been opened in the datasheet view, then you have to add or enter the name of the fields in the table.
· Press CTRL+W to save the table
Creating table using Design View
· In a database window select the tables tab 
· select “create tab” in the toolbar of MS-ACCESS 
· click on the Table Design button or option in the Tables group. This opens the design view window.
· When the table is opened in the design view, then you will see the three columns. The first column is Field Name, which allows a user to enter the name of a field, second column referred to as a Data Type and the third column is Description, which is optional. In this column, a user provides a short description of each field.
· In the design view window create the required fields
	FieldName
	Type
	Description

	Rno
	Number
	

	Name
	Text
	

	Gender
	Text
	

	Doj
	Date/time
	

	Course
	Text
	

	Fees
	Number
	


· Press Ctrl+w to save the table.
· Select the created table and press open button
· This opens a window which looks like spreadsheet. In the displayed window add the rows and press ctrl + w to save the table.
Steps to create table using table template
A table can be defined as collection of rows and columns. Within a table we can place any number of records.
Steps:
· Click the File tab then click Open.
· In the Open dialog box, select and open the database in which you wish to create a table.
· On the Create tab, in the Tables group, click Table Templates and then select one of the available templates from the list.
[image: Access Ribbon Image]
· A new table is inserted, based on the table template that you choose.
· On the Home tab, in the Views group, click View, and then click Datasheet View.
· On the Datasheet tab, in the Fields & Columns group, click New Field.
[image: Access Ribbon Image]
· Select one or more fields in the Field Templates pane, and then drag them to the table where you want to insert the new column.
[bookmark: bmimportlink]Primary key
This constraint allows the user not to accept duplicate values and null values. It is a entity integrity constraint.
Validation rule
This constraint allows the user to accept the data as per the conditions defined. It means the data which enters should satisfy the given condition.
Steps how to import a table
Steps:
1. Start your spreadsheet program and create a new, blank file. If you use Excel, a new, blank workbook is created by default.
2. Copy the sample table provided in the previous section and paste it into the first cell of the first worksheet.
3. Using the technique provided by your spreadsheet program, name the worksheet Customers.
4. Save the spreadsheet file to a convenient location and go to the next steps.
Import the table into Access
1. In a new or existing database: On the External Data tab, in the Import group, click Excel.
2. Click Browse, open the spreadsheet file that you created in the previous steps, and then click OK. The Import Spreadsheet Wizard starts.
3. By default, the wizard selects the first worksheet in the workbook, and data from the worksheet appears in the lower section of the wizard page. Click Next.
4. On the next page of the wizard, select First row contains column headings, and then click Next.
5. The next page of the wizard offers you an opportunity to change field names and data types or to omit fields from the import operation, by using the text boxes and lists under Field Options. You should not do this for this example. Click Next.
6. On the next page of the wizard, in the Field Options box, select Yes (No Duplicates) from the Indexed list, and select Long Integer from the Data Type list. Click Next to continue.
7. On the next page of the wizard, select the Choose my own primary key option, choose CustomerID from the list, and then click Next.
8. By default, Access applies the name of the worksheet to your new table. Make sure that the table is named Customers, and then click Finish.
9. On the last page of the wizard, you have the option of saving the import steps for later reuse. Because you are importing a sample table, it is not recommended that you save the import steps.


Types of Queries
A query is used to extract required information from the database.  A query can select a group of records that fulfill a certain condition. Most Access databases contain more than one table. Queries are of Different types. They are –
1. Select Queries
2. Parameter Queries
3. Crosstab Queries
4. Action Queries
5. SQL Queries
SELECT QUERIES: 
Select query is the most common type of query. It retrieves data from one or more tables and displays the results in a datasheet where you can update the records. You can also use a select query to group records and calculate sums, counts, averages, and other types of totals
PARAMETER QUERIES:  
A parameter query is a query that when run displays its own dialog box prompting you for information, such as criteria for retrieving records or a value you want to insert in a field. You can design the query to prompt you for more than one piece of information. 
CROSSTAB QUERIES: 
You use cross tab queries to calculate and restructure data for easier analysis of your data. Cross tab queries calculate a sum, average, count, or other type of total for data that is grouped by two types of information — one down the left side of the datasheet and another across the top.
ACTION QUERIES:
An action query is a query that makes changes to or moves many records in just one operation. There are four types of action queries. They are delete queries, update queries, Append queries and make multiple table queries
SQL QUERIES:
An SQL query is a query you create by using an SQL statement. You can use Structured Query Language (SQL) to query, update, and manage relational databases such as Access.
Steps to create Query using design View
Ans:
A query is used to extract required information from the database.  A query can select a group of records that fulfill a certain condition. Most Access databases contain more than one table.  
Steps:
1. In the database window select Queries tab and then select create query by Design view. This displays the window and over the window we can observe show table dialog box.
2. In the show table dialog box we can observe all the tables which we created. Select the table on which query to be performed.
3. A query window can be observed. It is in two halfs. The above half of the query window contains a table on which query is going to perform and on the lower half of the query window select the columns/fields whose data has to extract.
4. Press ctrl + w to save the query. Select the created query and open it, this contains the information of selected fields only.

Steps to create query using Query wizard
A query is used to extract required information from the database.  A query can select a group of records that fulfill a certain condition. Most Access databases contain more than one table.  
Steps:
1. On the Create tab, in the Other group, click Query Wizard.
2. In the New Query dialog box, click Simple Query Wizard, and then click OK.
3. Under Tables/Queries, click the table that has the data that you want to use. In this case, click Table: Customers. Note that a query can also use another query as a recordsource.
4. Under Available Fields, double-click the Contact, Address, Phone, and City fields. This adds them to the Selected Fields list. When you have added all four fields, click Next.
5. Name the query London Contacts, and then click Finish.
Access displays all of the contact records in Datasheet view. The results show all of the records, but show only the four fields that you specified in the query wizard.
FORM
Forms display and print data from a table or a query. Forms enable you to view, edit and print data in a custom format. Data-entry forms help users to enter information into a database table in an easy and accurate manner. Data-entry and display forms provide a more structured view of the data as compared to a datasheet. From this structured view, you can add, change, delete or view database records. 
Steps to create Form Using FORM Wizard
1. In the database window select the Forms tab where select “create Form by Form Wizard”. This displays Form Wizard.
2. In the Form wizard select the table name and fields for which form should be created and then press the NEXT button.
3. The Form Wizard displays layouts of forms. Select any one layout and then press the finish button. This creates a data entry form.
4. In the data-entry form we can enter the values and these values can be stored in the table. 
5. Press ctrl + w to save the form.
Report
Reports present your data in a printed format. It can able to extract data and can be presented to the user in a format required. You can create different types of reports with a DBMS. 
STEPS to create Report
1. In the database window select reports tab where select “Create Report by Report wizard”
2. This displays report wizard. In the Report wizard select the table name and fields for which a report should generate and then press the NEXT button.
3. This displays report wizard where select the layout of the report and then press the finish button. This generates report.
4. Press ctrl + w to save the report.


Entity Relationships 
Ans: It means providing relationships from one object to another. While providing relations between objects we should keep in mind that different objects must have one unique column. Data can be extracted from different tables by providing relations. The relations/ joins are of 3 types. They are
1. Only include rows where the joined fields from both tables are equal. 
2. Include all rows from one table and only those rows from other table where the joined fields from both tables are equal.
3. Include rows from one table and all rows from other table where the joined fields from both tables are equal. 
Steps to perform query by implementing relationships:
1. In the database window select Queries tab and then select create query in Design view. This displays the query window and over the window we can observe show table dialog box.
2. In the show table dialog box we can observe all the tables which we created. Select the tables on which query to be performed.
3. A query window can be observed. It is in two halves. The above half of the query window contain tables on which query is going to perform and select column of one table which is common in both tables and drag it over other table. This provides relationship between two tables.
4. On the lower half of the query window, select the columns/fields whose data has to extract. Press ctrl + w to save the query
5. Select the created query and open it. This shows the data from tables which required to the user.
Adding controls to customize an object(Form/Report)
When you’re looking to customize an Access form, view, or report, the most common task is to add or modify controls. These are the text boxes, buttons, combo boxes, and other tools you use to add, edit, and display the data.
Whether you’re working in an Access web app or an Access desktop database, you can add controls in one of two ways:
1. To create a control that is bound to a field, 
· open the Field List (Alt+F8) and drag the field from the list to the form, view, or report. 
· Access adds a control that is appropriate for the type of data stored in the field.
2. To create an unbound control,
· Click a control on the Design tab of the ribbon. 
· In an Access application, the control appears on the view immediately. 
· you’ll need to click on the form, view, or report where you want to place the control.
· If you want, you can convert an unbound control to a bound control by editing the properties for the control. Press F4 if you are using a desktop database to see the properties, then select a field name from the Control Source drop-down.
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